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Picarro Analyzer User Manual 

Thank you for purchasing a Picarro product. Your Picarro system is a quality product 
that has been designed and manufactured to provide reliable performance. 

This User Manual (UM) is an important part of your purchase as it will help familiarize 
you with the system and explain the numerous features that have been designed 
into it. Please read this manual thoroughly before using your Picarro system. 

Please contact Picarro or your authorized Picarro distributor should you have questions 
regarding specific applications or if you require additional information. 

NOTICES 

DISCLAIMER AND RESERVATION OF RIGHTS 

Picarro has prepared this manual solely for the information and use by its customers as 
a guide for the selection, installation, operation, and maintenance of the products 
described. 

EXCEPT AS PROVIDED IN THE TERMS AND CONDITIONS OF SALE FOR PICARRO 
PRODUCTS, PICARRO ASSUMES NO LIABILITY WHATSOEVER, AND PICARRO 
DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE OR USE 
OF PICARRO PRODUCTS, INCLUDING LIABILITY OR WARRANTIES RELATING TO 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

Picarro reserves the right to change or update the contents of this manual and the 
specifications of its products at any time, without notice. Picarro has endeavored to 
include information that is current and accurate as of the date of the publication or 
revision of this document, but Picarro does not guarantee that this document is error free 
or that it is accurate with regard to any particular specification. 

Picarro expressly reserves all intellectual property rights, including all intellectual 
property rights relating to any product described in this manual. This document does not 
grant any license, express or implied, by estoppel or otherwise, to any intellectual 
property rights of Picarro or any third party. 

PATENTS 

The products described in this manual are subject to Picarro patents and patents 
pending. Information about Picarro patents applicable to these products is available at 
www.picarro.com/company/patents 

TRADEMARKS 

Picarro and the Picarro logo are trademarks of Picarro, Inc. 

Windows® is a trademark of Microsoft Corporation 

Swagelok® is a trademark of Swagelok Company 

Copyright © 2023 Picarro, Inc. All rights reserved  
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Contact Information 

General Technical Support: 

Email:        support@picarro.com  

Phone:       +1 408 962 3991 

 

European Technical Center: 

Email:        support@picarro.com 

Phone:       +31 85 888 1650 

 

Orders Service: 

Email:        orders@picarro.com 

Phone:       +1 408 962 3992 
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READ BEFORE USING THE MANUAL 

This manual includes information on how to install the water analyzer in its most common 
configuration (Analyzer with Vaporizer). For other configurations (Autosampler, SDM, IM, 
MCM, CWS), please refer to those manuals directly: 

 A0325 Autosampler User Manual (PN 40025) 

 A0214 MCM User Manual (PN 40022) 

 A0213 Induction Module-CRDS Setup User Manual (PN 40033) 

 A0101 SDM User Manual (PN 40-0005) 

 A0217 Continuous Water Sampler Installation and User Manual  
(PN 40-0003) 

Please note that the High Throughput Vaporizer was discontinued in December 2013. Picarro 
continues to support these vaporizers in the field, but they are no longer manufactured. If you 
require installation instructions for the High Throughput Vaporizer, please refer to an older 
version of this manual.  

For information on Picarro’s measurement technology, see the section; INTRODUCTION TO 
TECHNOLOGY 

Be selective when following the manual by only referring to the sections that refer to 
the configuration of your interest. To start, choose one of the setups in the table below 
based on your configuration.  
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Refer to Table of Contents to find the location of any of the chapters described below. 

SETUP USE CASE SETUP CHAPTER 

Basic Water 
Analyzer 

This mode is used to measure 
ambient vapor which does not 
require any calibration with 
liquid standards. 

See Setup Configuration | Basic Water 
Analyzer Setup. This setup requires a CRDS 
analyzer.  

Dual Mode This mode is used for 
measurement of ambient 
vapor coupled with automated 
injection of liquid calibration 
standards. The measurement 
mode alternates between 
analyzing ambient vapor and 
liquid standards based on a 
user defined sequence. 

See Setup Configuration | Dual Mode 
Setup. This setup requires A0211 High 
Precision Vaporizer, A0912 Dual Mode 
Configuration hardware and software for 
vapor calibration and an Autosampler. The 
mode uses high precision method for liquid 
calibration. Each injection cycle takes 9 
minutes. 

Manual Mode This mode is used for semi-
automated measurement of 
liquid water samples with 
maximum precision. 

See Setup Configuration | Manual Mode 
Setup. The setup requires an A0211 High 
Precision Vaporizer and A0322 Syringe 
Guide. User manually injects samples after 
prompt. The control of the vaporizer and the 
analysis of liquid samples are automated. 
Each injection cycle takes 9 minutes. 

Picarro 
Autosampler 
and High 
Precision 
Vaporizer 
(A0211) 

This setup is used for 
automated injection of liquid 
waters. It consists of two 
modes that utilize the same 
hardware: High Precision 
Mode and High Throughput 
Mode. 

See Setup Configuration | Picarro 
Autosampler – High Precision Vaporizer 
(A0211) Setup. The setup can operate in 
five measurement modes: High Precision, 
High Throughput, Standard*, Express*, and 
Survey*.  

● High Precision*: Measures liquid 
water samples with maximum 
precision. Liquid samples are 
automatically injected and analyzed. 
Each injection cycle takes 9 minutes. 

● High Throughput*: Used for faster 
measurement of liquid water samples 
with good precision. Liquid samples are 
automatically injected and analyzed. 
Each injection cycle takes 4 minutes.  

High Precision and High Throughput 
Coordinator Modes operate in the 
exact same fashion except that the 
steps of sample preparation and 
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analysis are faster in the high 
throughput coordinator mode. 

● Standard**: Used to measure liquid 
water samples with maximum 
precision.  This coordinator must be 
run in either the “iH2O N2” mode or the 
“iH2O Air” mode. Automatically injects 
and analyzes liquid samples. Each 
injection cycle takes 9 minutes. 

● Express**: Used for faster 
measurement of liquid water samples 
with good precision.  This coordinator 
must be run in either the “iH2O N2” 
mode or the “iH2O Air” mode. 
Automatically injects and analyzes 
liquid water samples. when using the 
Express coordinator, we recommend 
10 injections, the first 6 injections take 
1.5 minutes each, while the last 4 
injections take 5 minutes each. The 
first 7 injections will be discarded to 
achieve the optimal memory reduction.  

● Survey**: Used for super-fast 
measurements of large sample batches 
at moderate precision and enables 
more efficient sample sorting. By 
manually rearranging samples 
accordingly, one can reduce the 
memory effect between adjacent 
sample.  Automatically injects and 
measures liquid samples. This 
coordinator must be run in either the 
“iH2O N2” mode or the “iH2O Air” 
mode 

*Only available without Coordinator software 
upgrade 

**Only available with Coordinator software 
upgrade 
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1. INTRODUCTION TO TECHNOLOGY 
Picarro analyzers use time-based, optical absorption spectroscopy of the target 
gases to determine concentration in a sample. They are based on wavelength-
scanned cavity ring-down spectroscopy (WS-CRDS), a technology in which light 
travels many times through the sample, creating a very long effective path length 
for the light to interact with the target gas, thus enabling excellent detection 
sensitivity in a compact and rugged instrument.  

The Picarro analyzer is comprised of two modules: 

 The Analyzer contains the spectrometer, sample chamber, and a 
computer with a hard drive to store and analyze data. The single 
analyzer module controls the operation of the system and converts 
spectroscopic measurements into gas concentration data. 

 The External Vacuum Pump draws the sample gas through the 
instrument. 

1.1 Cavity Ring-Down Spectroscopy (CRDS) 

Nearly every small gas-phase molecule (e.g., CO2, H2O, H2S, NH3) and 
isotopologue (e.g., H2

18O, 13CO2, 15N14N16O) uniquely absorb specific 
wavelengths of near-infrared light. The strength of the light absorption is 
related to the concentration of a molecule in a sample and the distance that 
light travels through the sample, called the path length.  

Conventional infrared spectrometers are typically only sensitive enough to 
detect trace gases at levels in the part-per-million. Cavity Ring-Down 
Spectroscopy (CRDS), on the other hand, is one thousand to one million 
more times sensitive.  

The increased sensitivity of CRDS is due to the design of the sample cavity 
and the time-based measurement. In the cavity, a series of mirrors reflects 
the infrared light through the sample, increasing the path length. For a 
Picarro cavity of only 25 cm in length, the effective path length of the cavity 
can be over 20 kilometers.  

In Picarro analyzers, light from a single-frequency laser enters a cavity 
where three mirrors reflect the laser light as seen in Figure 1. The light 
enters through the mirror closest to the laser, bounces off the angled mirror 
in the lower right corner of the cavity, travels to the hemispherical mirror at 
the top of the cavity, bounces toward the mirror in the lower left corner of 
the cavity, and then returns to the first mirror. This motion becomes a 
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continuous traveling light wave, which is represented by the dark orange 
path in Figure 1. 

Figure 1: 
Schematic of 

the Picarro 
CRDS analyzer 

cavity 

  

When the laser is on, the cavity quickly fills with laser light. A small amount 
of the laser light is transmitted through the mirror closest to the 
photodetector, which turns the incident light into a signal that is directly 
proportional to the light intensity in the cavity. 

When the photodetector signal reaches a threshold level (in a few tens of 
microseconds), the laser is turned off. The light contained within the cavity 
continues to bounce between the mirrors (about 40,000 times). Since the 
mirrors have slightly less than 100% reflectivity (99.999%), the light inside 
the cavity steadily leaks out of the cavity. The intensity of the light reaching 
the detector decreases, falling exponentially until it reaches zero. This 
decay, or "ring-down,” is measured in real time by the photodetector. 

1.2  Relating ring-down time to absorption intensity 

The time it takes to ring-down is inversely related to the total optical loss in 
the cavity, including the strength of molecular absorption at a given 
wavelength of light. For an empty cavity, the time it takes for the intensity to 
decrease by a given percent is determined solely by the reflectivity of the 
mirrors. A cavity containing gas that absorbs light will have a shorter ring-
down time than an empty cavity. As the light circulates in a cavity with a 
gas sample, the molecular absorption by the gas results in a decrease of 
the light intensity. 



 
 

 

12 P/N 40035 Rev. F L21x0-i Inst/Op Manual 

Determining absorption intensity at a specific wavelength requires 
comparing the ring-down time of an empty cavity to the ring-down time of a 
cavity that contains gas. A cavity can be empty if it contains no gas; it will 
also appear empty if the molecules of the sample inside the cavity do not 
interact with the specific wavelength of light.  

Picarro instruments gather measurements from an “empty” cavity by 
switching the light to wavelengths that are not absorbed by the target 
molecules. The analyzer subsequently measures ring-down times at 
wavelengths that are absorbed by the target gas. The analyzer 
automatically and continuously compares these two types of ring-down 
times, and the software uses those comparisons to calculate absorption 
intensities. 

Figure 2: 
Light intensity 

as a function of 
time in a CRDS 

system 

  

1.3  Converting absorption intensity to concentration 

Plotting the absorbance at each measured wavelength generates an 
optical spectrum. This spectrum contains absorbance peaks that are 
unique to each molecule in the sample. The height of a particular 
absorption peak is proportional to the concentration of a molecule that 
generated the signal.  

The height of the peak is calculated by subtracting the maximal 
absorbance from the baseline absorbance. Figure 3 shows a plot of ideal 
optical spectra with a clean, uniform baseline on either side of the 
absorption peak. 
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Figure 3: 
Absorption 

Spectral Curve 

  

However, optical spectra often contain several absorption lines, nested 
closely together. A particular absorption peak may be visible between lines, 
but the absorption may not return to the baseline before it rises in response 
to another molecule.  

Picarro analyzers calculate the baseline underneath a poorly resolved peak 
by modeling the absorption peaks from other surrounding molecules and 
subtracting contributions from neighboring peaks to the absorption 
intensity.  

1.4 Spectral precision and high sensitivity measurements 

Picarro analyzers contain two features that provide high spectral precision:  

 A proprietary wavelength monitor (WLM) that measures the absolute 
laser wavelength to a precision that is a few orders of magnitude 
narrower than the spectral linewidth: Picarro’s patented WLM measures 
absolute laser wavelength to a precision more than 1,000 times 
narrower than the observed Doppler-broadened linewidth for small gas-
phase molecules. The instruments lock the laser to the WLM, and then 
the monitor tunes to wavelengths known to be maximally and minimally 
absorbed by the target molecule. The result is closely clustered 
absorption intensities, measured at wavelengths just before peak 
absorption, at peak absorption, and just after peak absorption, as the 
absorbance returns to the baseline.  

  



 
 

 

14 P/N 40035 Rev. F L21x0-i Inst/Op Manual 

 Precise temperature and pressure control in the sample cavity: 
Accurate absorption measurements at precisely known wavelengths 
account for little unless the temperature and pressure of the CRDS 
measurement cavity are known. The observed line intensity and shape 
depend on the temperature and pressure inside the sample cavity. 
Small temperature and pressure instabilities can result in large 
concentration errors due to fluctuating peak heights and baselines. To 
completely minimize instrument measurement drift, temperature and 
pressure must be actively stabilized to constant values.  

For precise temperature control, the sample cavity is surrounded by layers 
of thermally insulating material to provide a high degree of passive thermal 
stability. The cavity is further actively stabilized by means of a solid-state 
heating system locked to the output of a thermal sensor. This enables the 
temperature of the cavity to be within 20 mK of the set temperature.  

For precise pressure control, the cavity pressure is monitored using a high-
linearity pressure transducer. The system computer uses this pressure 
data in a feedback loop to control proportional valves that adjust the inlet 
and outlet gas flow of the cavity.  
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2. CONVENTIONS 
The following icons are used throughout this manual to emphasize important 
information in the text. These icons indicate dangers to either the operator or to the 
analyzer, and other important information. 

 

Consult the user manual for important information 
(When you see this symbol placed at hazard points 
on equipment, consult the user manual). 

 

NOTE is important information that you should be 
aware of before proceeding. 

 
WARNING 

LASER WARNING alerts you of a laser danger. 

 
CAUTION 

CAUTION alerts you of a potential danger to 
equipment or to the user. 

 
WARNING 

WARNING indicates an imminent danger to the 
user. 

 
REMINDER 

REMINDER is a helpful hint to procedures listed in 
the text. 
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3. ACRONYMS 
This manual includes various acronyms. For definitions, see below:  

Acronym Definition 

cm centimeters  

CRDS Cavity Ring-Down Spectroscopy  

CWS Continuous Water Sampler 

DAS Data Acquisition System (the Analyzer) 

DIO 

Digital Input and Output Between the Analyzer and the 
Autosampler. DIO Tells the Autosampler to prepare for an 
injection, and also to do an injection. Additionally, DIO is the 
place where the autosampler notifies that an injection has been 
made. 

GUI Graphical User Interface  

H2O Water  

HB Hotbox  

IM Induction Module 

MCM Micro-combustion Module 

mm millimeters  

ppb Parts Per Billion  

ppm Parts Per Million  

SDM Standards Delivery Module 

WB Warm box  

WLM Purge 
Port 

Wavelength Monitor Purge Port. The Port on the Analyzer the 
dry gas connects to. This keeps the spectroscopy accurate. 
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Acronym Definition 

” (as in 1/4”) Inches 

°C degrees Celsius  

‰ per mil  
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4. SAFETY 

4.1 General Safety 

CDRH Certification 

This Picarro Analyzer complies with 21 CFR Chapter 1, sub-chapter J, and 
is classified as a Class 1 laser system when all panels and covers are on. 

CE Certification 

This Picarro Analyzer complies with the European standards and the 
instrument is affixed with a CE label. This CE label is located on the rear of 
the instrument. 

 

 
WARNING 

Using this analyzer in a manner not specified by Picarro may result 
in damage to the analyzer and render it unsafe to operate. 

 

 
WARNING 

This analyzer is for indoor use only and has an ingress protection 
rating of IPx-0. Analyzer is NOT protected against exposure to 
water including dripping, spraying, splashing or immersion. 

 

 
WARNING 

Do not operate in an explosive atmosphere! Do not operate in the 
presence of flammable gases or fumes.  

 

 
CAUTION 

The analyzer contains no user serviceable components except the 
analyzer particulate filter and vaporizer injection port septum. Do 
not attempt repairs; instead, report all problems to Picarro 
Customer Service or your local distributor. Please contact Picarro 
if you have any questions regarding the safe operation of this 
equipment. 
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WARNING 

The inlet gas connector on the back panel of the Analyzer, and its 
immediate vicinity, runs hot during operation of the analyzer. Take care 
when connecting gas lines or working at the rear of the instrument to 
wear protective gloves or avoid contact with these surfaces. 

 

 
WARNING 

This analyzer and pump weighs 45 lbs (20.4 kg). 

Use the technique described below when lifting the analyzer. 

a. Before lifting, inspect the unit for slippery substances or sharp 
edges. 

b. Lift with two people, one on each side of the analyzer. 
c. Crouch down and stay close to the unit. Always keep your back as 

straight as possible.  
d. Position your feet for sturdy balance. Lift with your legs, not your 

back.  
e. Do not twist the back while carrying the unit. Rotate direction with 

hip joints.  
f. Lower the unit by bending at the knees.  

4.2 Laser Safety 

 
WARNING 

This equipment is classified as a Class 1 laser product with an 
embedded 3B laser in accordance with EN 60825-1:2014. Do not to open 
the enclosure where this label is placed; there are no user serviceable 
parts inside. 

 
The following Laser Safety Label is affixed to the outer cover of the 
analyzer. 

 

 

 
WARNING 

The laser is a Class3B when exposed.  
Only operate or service this device in accordance with the instructions 
in this guide, and only open the device in an approved laser safe 
service area using appropriate laser-safety glasses. 
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The following Laser Safety Label is affixed to the inside of the analyzer:  

Figure 4: 
Laser Safety 

Label 

 

 

 
WARNING 

Use of controls or adjustments or performance of procedures other 
than those specified herein may result in hazardous radiation 
exposure. 
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5. UNPACKING THE ANALYZER 

5.1 Inspect the Shipping Boxes 

Picarro products are inspected and tested before leaving the factory. Their 
packing containers have been designed to keep the equipment safe from 
damage during transit. 

Inspect the condition of the boxes upon arrival. The larger box includes the 
analyzer and most of the accessories. Even if the outer box shows 
damage, the inner box holding the analyzer is cushioned enough that it will 
protect the instrument under most circumstances. 

 
NOTE 

If the equipment appears to be damaged, photograph the damaged 
areas and contact Picarro (email pictures if possible) as soon as 
possible. 

5.2 Unpack the Shipping Boxes 

This section describes the contents of the shipping boxes: 

 Inspect each item to ensure it is not damaged.  

 If items are missing, contact Picarro. 

 Keep the shipping packages to reuse when transporting the 
analyzer. 

 Contact Picarro for options on transporting systems to remote 
labs. 

 
WARNING 

This analyzer weighs 45 lbs (20.4 kg). Use the technique outlined in 
the General Safety section on page 19 when lifting or moving the 
analyzer.  
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Figure 5: 
Box 

Contents 

 

Box One: Analyzer and Accessories  

Item (qty) Description 

Analyzer (1) Includes all the data acquisition, control, and 
communications hardware and firmware to 
perform all gas handling, spectral collection 
and analysis. 

A/C Power  
Cables (1) 

A power cable with connectors appropriate to 
your country is provided. The analyzer 
automatically adjusts to local voltage. 

Keyboard (1) USB keyboard 

Mouse (1) USB mouse 

Control Cable (1) For External Solenoid Valves 

Nut (1) and 
Ferrules (2) 

For connecting input line to analyzer INPUT 

Document 
Packet (1)  

Includes this manual, certificate of compliance, 
and Windows License. 

USB Flash Drive  Contains backup software. 
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Box Two: Vacuum Pump and Accessories 

Item (qty) Description 

Pump (1) Provides vacuum required for sample gas 
sequencing into and out of the analyzer. 

A/C Power  
Cable (1) 

A power cable with connectors appropriate to 
your country is provided. The pump 
automatically adjusts to local voltage. 

Vacuum Hose (1) Hose to connect the pump to the analyzer. 

Pump Manual (1) Detailed instructions for pump. 
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6. ANALYZER OVERVIEW 

6.1 Intended Use 

The L2140-i Isotopic Water Analyzer measures concentrations of δ18O, 
δ17O, δD and 17O-excess using Picarro’s patented Cavity Ring-Down 
Spectroscopy (CRDS).  

The L2130-i Isotopic Water Analyzer measures concentrations of δ18O and 
δD.  

The analyzer can be deployed for monitoring applications in a lab or in the 
field, allowing in-situ analysis of trace and ambient amounts of isotopic 
water. 

6.2 External Vacuum Pump 

The external vacuum pump is used to maintain cavity pressure inside the 
analyzer. The pump should be connected and running whenever the 
analyzer is in use. 

6.3 Analyzer Specifications 

Weight 45 lbs (20.4 kg) 
 Dimensions Analyzer: 17” w x 7” h x 17.5” d (43.2 x 17.9 x 44.6 cm), 

not including 0.5” feet 
 
External Pump: 6.1” w x 8.7” h x 13.6” d (15.5 x 22 x 
34.5 cm) 

Temperature Range –10 °C to 45°C (vapor sample), 
10 to 35°C (liquid sample and system operation) 
–10 °C to 50 °C (storage) 

Sample Pressure 300 to 1000 Torr (40 to 133 kPa) 

Sample Flow Rate ~40 sccm at 760 Torr, no filtration required 

Ambient Humidity Range  <85% R.H. non-condensing 
Maximum Altitude 10,000 ft. (operation) 

Clearance Front: 6" (15.3 cm); Rear: 6" (15.3 cm) 

Power Requirements 

Startup Power 

Steady-state Power 

Mains Voltage Fluctuation 

100 to 240 VAC; 47 to 63 Hz (auto-sensing) 

<375 W at start-up (Analyzer and Pump) 

120 W (Analyzer), 150 W (Pump) Steady-state operation 

±10% of the nominal voltage 
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Mains supply voltage 
fluctuation 

±10% of nominal voltage 

Minimum Rated Circuit Current 10 A @115 VAC, 5 A @230 VAC 

Liquid Ingress Protection None 

6.4 Analyzer Operation Flow Diagram 

To measure discrete samples (such as individual gas bags) or from 
multiple locations (when switching valves draw in ambient air from different 
heights), a separate software window (coordinator) is used to control the 
sample source and match the corresponding real time read out with the 
sample source. Depending on system configuration, coordinator programs 
may not be included. Figure 9 shows analyzer operation as a flow diagram. 

Figure 6: 
Analyzer 

Operation Flow 
Diagram 

 

1. The samples A, B, and C are introduced into the analyzer 
sequentially. 

2. The timing of sample introduction is controlled by coordinator or 
valve sequencer software. 

3. The analyzer measures samples continuously and reports the data 
to the GUI. 

4. The GUI saves a single file where all data is reported as a function 
of time. The coordinator gets data from the GUI and creates a single 
file, the data is reported as a function of sample. 
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5. Before shutdown, Picarro recommends flowing clean dry air (CDA) 
through the analyzer for several minutes. This prevents moist gas in 
the cavity from condensing on the optics as the analyzer cools.  
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7. INSTALLATION 
This section describes the setup and installation of the Picarro Analyzer. Please 
read and understand this section thoroughly before proceeding with the 
installation. 

 
WARNING 

Using this analyzer in a manner not specified by Picarro may result 
in damage to the analyzer and render it unsafe to operate. 

 

 
WARNING 

Analyzer is for indoor use only and has an ingress protection rating 
of IPx-0. Analyzer is NOT protected against exposure to water 
including dripping, spraying, splashing or immersion. 

 

 
WARNING 

Do not connect USB hubs or unauthorized USB devices (except 
flash drives, mice and keyboards) to the USB ports. Unauthorized 
USB devices may interfere with the analyzer function. 

 

 
WARNING 

Equipment Damage: Do not attach electrical power to or start the 
analyzer until after attaching and turning on the External Vacuum 
Pump. Do not disconnect the vacuum line while the analyzer is 
running. Failure to do so could result in damage to the optics. 

 

 
WARNING 

Picarro sells USB enabled devices, such as GPS, which is 
approved for use. Please do not connect USB hubs or unapproved 
USB devices, other than flash drives to the computer because they 
can interfere with the operation of the analyzer. 

 

 
WARNING 

If rack mounted, the Analyzer cannot support itself using a front 
rack mount kit alone. The instrument must be supported by a shelf 
or additional rails attached to the rack. 
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CAUTION 

If the analyzer has been stored at less than 10 °C, allow the 
components to equalize to room temperature before starting the 
installation process. 

 

 

CAUTION 

When the analyzer is being integrated to an external system, the 
safety of that system is the responsibility of the assembler of that 
system.  

 

 

CAUTION 

During installation and operation, do not position the analyzer so 
that it is difficult to operate the disconnecting device.  

 

 
NOTE 

Take care to ensure that warm air is exhausted from an enclosure 
in which the analyzer is mounted. 

 

 
CAUTION 

It is imperative that the analyzer have adequate ventilation and/or 
cooling to maintain the ambient temperature below 35 °C when 
operating. Failure to provide adequate airflow, especially clearance at 
the front and rear panels, to ensure proper airflow and/or cooling to the 
analyzer will result in overheating of the analyzer causing a shutdown 
and potential damage. There should be 4” (10cm) of clearance in the 
front and back of the analyzer. 
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WARNING 

Equipment Damage: If one accidentally over-saturates the 
instrument with water, it is very important that one does not turn 
the instrument off. Rather, let the instrument pull either room air or 
dry air/N2 through for a few days to dry out the cavity -- until the 
instrument can make measurements normally again. If the 
instrument is turned off right after the accident, water will 
condense and contaminate the cavity rendering it useless. The 
cavity repair can be up to 25,000 USD. 

7.1 Analyzer and Vacuum Setup 

1. Remove the Analyzer and the External Vacuum Pump from their 
respective shipping containers. 

 
WARNING 

This analyzer weighs 45 lbs (20.4 kg). Use the technique outlined in 
the General Safety section on page 19 when lifting or moving the 
analyzer.  

2. Place the Analyzer on a bench top or flat surface. Place the 
External Vacuum Pump near-by or on the floor. Don’t push the 
analyzer into position yet, there are cables to be installed on the 
back panel. 

3. Unpack the analyzer accessories. The Certificate of Compliance 
and USB drive should be stored in a safe place and may be 
required if you contact Picarro with questions about your 
analyzer. 

4. Remove the caps from the analyzer’s INLET and VACUUM 
connection ports. Save the caps; you should reinstall them when the 
analyzer is stored, moved or shipped. 

5. Remove the cap from vacuum pump’s inlet. Save the cap for later 
use. Reinstall the caps when the pump is stored, moved or shipped.  

6. Connect one end of the vacuum hose to the pump: hand tighten the 
nut and then use an 11/16" wrench (not included) to make an 
additional turn of one flat (about 60 degrees).  

7. Connect the analyzer to a power source using the supplied AC 
power cable.  
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CAUTION 

Use the AC power cables supplied with the analyzer or a similarly 
rated cable. Check with Picarro technical support if you have 
questions about power cable replacement. An inadequately rated 
power cable can result in equipment damage. 

 

 
CAUTION 

Cords shall be RATED for the maximum current for the equipment 
and the cable used shall meet the requirements of IEC 60227 or IEC 
60245. Cords certified or approved by a recognized testing 
authority are regarded as meeting this requirement. The connector 
type used should be: IEC320 C13. 

8. If desired, attach a tube to the External Vacuum Pump exhaust port 
and direct to a safe place for venting the mixture of sample gases. 

9. Select the appropriate voltage, 110V or 220V, for the External 
Vacuum Pump using the Power Switch located on the pump. 

10. Connect the External Vacuum Pump to a power source using the 
other AC power cable. 

Figure 7: 
Rear panel 

connections 

 

 

 
WARNING 

Equipment Damage: Never disconnect the vacuum hose unless the 
pump and analyzer are OFF. Otherwise, the system may be 
damaged. 

 

WLM Purge 
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NOTE 

The software to operate the instrument will start automatically after 
the operating system has loaded. The user interface will appear a 
few seconds after the instrument software starts. See “Startup 
Procedure” in Section BASIC OPERATION. 

7.2 Connecting to the Analyzer Inlet 

Connect to the inlet of the analyzer using ¼" OD PTFE or PFA tubing using 
the supplied plastic ¼" PFA inlet nut and ferrules. 

 
WARNING 

When using compressed gases, follow all appropriate safety 
conventions, including use of eye protection, physical restraint of 
cylinders, etc. 

Making a New Connection: 

When using new tubing, follow these steps. 

1. Place the two ferrules inside the nut as shown. 

Figure 8: 
Orientation of 

ferrules and nut  

 

2. Loosely connect the nut to the INLET on the back panel of the 
analyzer about a full turn, being careful not to let the ferrules fall out. 

3. Insert the tubing into the back of the nut, feeding it in as far as 
possible without deforming the tubing. 

4. Hand tighten the nut. 

5. Using a 5/8" wrench (not included), tighten the nut approximately 
seven flats (420 degrees). 

Replacing a Connection  

When reattaching tubing that already has a nut connected: 

1. Inspect ferrules. If you see any damage, replace the ferrules and 
follow the directions above for making a new connection. 

2. If there is no damage, hand tighten the connector to the analyzer’s 
INLET. 
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3. Using a 5/8" wrench (not included), tighten the nut approximately 
one flat (60 degrees).  

7.3 Setting Up a Monitor, Keyboard, and Mouse 

A video monitor (not included), keyboard, and mouse are required for 
monitoring device operations, viewing, or changing settings (including 
setting user permissions), or validating device performance. 

 

 
NOTE 

This device will operate under its default settings without any direct 
control of the internal software. 

 

1. Connect a keyboard to one of the available USB ports. 

2. Connect a mouse to one of the available USB ports. 

3. Connect a monitor to one of the monitor ports. The analyzer will 
detect the connection and adjust the resolution to match the 
monitor. 

4. Connect the monitor to a power source. 

5. Turn on power to the monitor. 

7.4 Dual Mode Setup 

Refer to Figures 9, 10, and 11 below. 

1. Inspect the boxes of Picarro products before opening. Carefully 
unpack the boxes and prepare the facility.  

2. Please review the important safety notes before continuing on with 
the installation. See Safety. 

3. Install the Analyzer and its External Vacuum Pump (see Analyzer 
and Vacuum Setup). 

4. Install the Picarro Autosampler (see Installation | Picarro 
Autosampler chapter in the A0325 Autosampler User Manual (PN 
40025).  

5. Attach the vaporizer switching valve assembly to the vaporizer inlet 
ports labelled Purge and Sample 2. 

6. Attach the gas line to T section of the vaporizer switching valve 
assembly. 
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7. Sampling tubing for measuring ambient water vapor should be 
connected to the back of the solenoid valve.  

Figure 9: 
Vaporizer 
Switching 

Valve 
Connected to 

Vaporizer. 

 

 

Figure 10: 
Connections 

on the back of 
the vaporizer 

 

8. Supply dry gas to the Analyzer (see WATER ANALYZER DRY 
GAS SUPPLY SETUP). Monitor purge should be at a pressure of 
2.5 ± 0.5 psig (0.17 ± 0.03 bar) from the gas supply/regulator. 



 
 

 

34 P/N 40035 Rev. F L21x0-i Inst/Op Manual 

9. Make sure all power cables are attached to the power outlets on the 
analyzer, vaporizer, external pumps and autosampler power block. 
However, keep the power switch off.  

10. Carefully slide the complete system into position. Small movements 
of the components relative to one another is OK, as the units are 
well locked. However, do not overly force the system; check for 
obstacles if the unit does not slide easily. 

11. Power up the system: Plug in all the power cables (including the one 
for the monitor) into the appropriate power supply. Switch ON the 
components in the following order: 

a) Both external vacuum pumps 

b) Everything else 

 
NOTE 

The software to operate the instrument will start automatically after 
the operating system has loaded. The user interface will appear a 
few seconds after the instrument software starts. See “Startup 
Procedure” in Section BASIC OPERATION. 

 

 
NOTE 

As the instrument is starting up, it is normal for there to be a delay 
in reporting data. This can take several minutes depending on how 
long it takes for the internal temperature to reach its operating 
point, and it is normal during this time for some concentration 
readings to be negative or constant. Additionally, the data selection 
pull down menus will not be populated with the appropriate items 
until data is actually being reported in the graph. This is typically 
less than 30 minutes, but depending on ambient temperature, the 
analyzer can take up to 2 hours to stabilize. 

 

 
NOTE 

Remember that for the SDM operation, the Vaporizer temperature 
should be set to 140°C. For all the other coordinator modes, the 
temperature should be set to 110°C. 

  



 
 

 

L21x0-i Inst/Op Manual P/N 40035 Rev. F 35 

 

Figure 11: 
Dual Mode 

Setup 
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7.5 Manual Mode Setup 

Refer to Figures 12, and 13 below. 

1. Inspect the boxes of Picarro products before opening. Carefully 
unpack the boxes and prepare the facility. 

2. Please review the important safety notes before continuing on. See 
Safety section.  

3. Set up the Analyzer and its external vacuum pump (see Analyzer 
and Vacuum Setup). 

4. Place the vaporizer on top of the analyzer using feet of 0.5” (13 mm) 
thickness to set it to the appropriate height. Align the Inlet port 
(analyzer) with the delivery port of the vaporizer.  

5. Attach a (N2 or Dry Air) Gas line to the Vaporizer and the Analyzer 
(see WATER ANALYZER DRY GAS SUPPLY SETUP). 

6. Find the external vacuum pump for the vaporizer, the hose with 
fittings attached, and the power cord for the vaporizer. Attach the 
hose at the vaporizer’s vacuum port and connect it to the External 
Vacuum Pump. Attach the power cable to the External Vacuum 
Pump, but keep the power switch off. 

Figure 12: 
Pump Rear 

Panel 

 
The pump exhaust port may come with a muffler attached for noise reduction. 

7. Connect the Vaporizer and the Analyzer using a Valve Cable and 
the gas delivery port from the vaporizer (see VAPORIZER TO 
ANALYZER CONNECTIONS). 

8. Check the Power Connections to the Machines: Make sure all 
power cables are attached to the power outlets on the Analyzer, 
Vaporizer, and two External Vacuum pumps. However, keep the 
power switch off.  
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9. Carefully slide the complete system into position: Small movement 
of the components relative to one another is OK. However, do not 
overly force the system. Check for obstacles if the unit does not 
slide easily.  

10. Plug all the power cables (including the one for the monitor) into a 
power supply. Switch ON the components in the following order 

a) External Vacuum Pumps (for the analyzer and the vaporizer). 

b) Everything else.  
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Figure 13: 
Manual Mode 

Setup 
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7.6 Picarro Autosampler and High Precision Vaporizer 
(A0211) Setup 

Refer to Figure 14 below. 

1. Inspect the boxes of Picarro products before opening. Carefully 
unpack the boxes and prepare the facility.  

2. Please review the important safety notes before continuing on with 
the installation. See SAFETY.  

3. Install the Analyzer and its External Vacuum Pump (see Analyzer 
and Vacuum Setup). 

4. Install the Picarro Autosampler (see Installation | Picarro 
Autosampler chapter in the A0325 Autosampler User Manual (PN 
40025).  

5. Supply dry gas to the Analyzer (see WATER ANALYZER DRY 
GAS SUPPLY SETUP). 

6. Carefully slide the complete system into position: Small movement 
of the components relative to one another is OK, as the units are 
well locked. However, do not overly force the system: check for 
obstacles if the unit does not slide easily. 

7. Power up the system: Plug in all the power cables (including the one 
for the monitor) into the appropriate power supply. Switch ON the 
components in the following order: 

a. Both external vacuum pumps 

b. Everything else 

 
NOTE 

The software to operate the instrument will start automatically after 
the operating system has loaded. The user interface will appear a 
few seconds after the instrument software starts. See “Startup 
Procedure” in Section BASIC OPERATION. 

 

 
NOTE 

As the instrument is starting up, it is normal for there to be a delay 
in reporting data. This can take several minutes depending on how 
long it takes for the internal temperature to reach its operating 
point, and it is normal during this time for some concentration 
readings to be negative or constant. Additionally, the data selection 
pull down menus will not be populated with the appropriate items 
until data is actually being reported in the graph. This is typically 
less than 30 minutes, but depending on ambient temperature, the 
analyzer can take up to 2 hours to stabilize. 
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NOTE 

Remember that for the SDM operation, the Vaporizer temperature 
should be set to 140°C. For all the other coordinator modes, the 
temperature should be set to 110°C. 

 

Figure 14: 
Picarro 

Autosampler-
High Precision 

Vaporizer 
Setup 
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8. WATER ANALYZER DRY GAS SUPPLY 
SETUP 

The Picarro L2140-i and L2130-i analyzers each can work in many configurations, 
allowing a wide application of the analyzer. This chapter describes how to set up 
the dry gas supply for all these configurations. Find the section in this chapter that 
relates to your setup and then complete the gas supply installation steps.  

 Manual Mode Setup  See Dry Gas Configuration A 

 Picarro Autosampler – High Precision Vaporizer (A0211) Setup  See 
Dry Gas Configuration A 

 Picarro Autosampler – High Throughput Vaporizer (A0212) Setup  
See Dry Gas Configuration B 

 Basic Water Analyzer Setup  No dry gas supply necessary 

 Dual Mode Setup  See Dry Gas Configuration C 

 Induction Module Setup  See A0213 Induction Module to CRDS Setup 
User Manual (PN 40039) 

 SDM Setup  See A0101 Standards Delivery Module CRDS Setup User 
Manual (PN 40-0005) 

8.1 Dry Gas Configuration A 

You will need a dry gas supply for the analyzer and the vaporizer. You can 
purchase the pressure regulator kit #A0921 or A0293 from Picarro. If you 
have already purchased a dry gas kit from Picarro, you will need the 
following additional supply.  

 Dry gas supply of 10-60 psi (4 bar), which is stepped down to 
2.5 psi before being connected to the CRDS analyzer.  

Below, you will find a complete part list and diagram on how to connect dry 
gas to the water analyzer.  

1. Attach the (N2 or Dry Air) Gas Line to the Analyzer: Attach a Gas 
line from the “WLM Purge” Port on the Analyzer to the N2 Regulator, 
which connects to a (nitrogen or dry air) gas cylinder.  

2. To connect 1/4” dry gas tube to the Wavelength Monitor Purge 
(WLM Purge) Port on the Analyzer, one needs to use the Push 
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Connector that is attached to the port. The connector is in two 
pieces: The Outer Flap and the Inner Flap.  

3. To connect the tube to the port, simply push the tube into the 
connector and then pull the tube back. If there is a space between 
the inner flap and the outer flap, this means that the tube is locked 
to the port. Do not twist and turn. To take the tube out of the port, 
push the Outer Flap in against the Inner Flap, and while doing this, 
pull out the tube. This will cause the gripping mechanism to release 
from the tube.  

Figure 15: 
Configuration A 

 

1. Q1-14B-580 Air Liquide Scott Regulator 
2. SS-OGM2-S2-A Swagelok Toggle Valve:  
3. SS-T2-S-028-20 Swagelok 1/8" OD stainless steel tubing 
4. SS-200-3 Swagelok 1/8" stainless steel Tee union 
5. SS-400-R-2 Swagelok 1/8" (adapter fitting) to 1/4" (tube fitting) 

Reducing Union 
6. 5033K31 McMaster-Carr 1/4" OD PTFE tubing 

Additional tools and parts are required, some others recommended. For 
the list, please click on the link below which will require you to have a 
Picarro community account. 
https://picarro.box.net/shared/static/r19c3z8etk.pdf 
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4. Attach the Gas (N2 or Dry Air) Line to the Vaporizer: Using either 
output from a (nitrogen or dry air) gas cylinder (should be at a 
pressure of 2.5 ± 0.5 psig (0.17 ± 0.03 bar)) or from the gas 
supply/regulator, attach the gas line to the open third leg of the gas 
line that connects the vaporizer purge and the sample ports (that is 
shipped connected to the vaporizer). 

Figure 16: 
Type 

description 
here 

 

Above is an N2 Regulator: The semi-transparent tube on the left is 
routed to the ‘WLM Purge” Port on the Analyzer. The copper colored 
tube on the top left comes from the ‘Purge’ and the ‘Sample’ ports on 
the Vaporizer. The copper colored tube on the bottom right goes to 
the the (N2 or Dry Air) Gas Cylinder. 
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Figure 17: 
Vaporizer and 

Analyzer 
Connections 

WLM Purge port back of the analyzer.  
 

 

Gas and electrical connections at rear of vaporizer  
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8.2 Dry Gas Configuration B 

The gas connection for the Dual Mode setup is very similar to the Dry Gas 
Configuration A except that it also has a Vaporizer Switching Valve. Follow 
the Dry Gas Configuration A, but also connect the Vaporizer Switching 
Valve back of the Vaporizer according to the schematic and images below.  

Figure 18: 
Dry Gas 

Configuration B 
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Figure 19: 
Vaporizer 
Switching 

Valve 
Connected to 

Vaporizer. 
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8.3 Dry Gas Configuration C 

For the SDM setup, you only need to supply dry gas to the CRDS analyzer. 
(Figure 20). 

Figure 20: 
Dry Gas 

Configuration C  
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To connect a 1/4” dry gas tube to the Wavelength Monitor Purge (WLM 
Purge) Port back of the Analyzer, use the Push Connector attached to the 
port.  

The connector is in two pieces: The Outer Flap and the Inner Flap. To 
connect the tube to the port, simply push the tube into the connector and 
then pull the tube back.  

If there is a space between the inner flap and the outer flap, this means 
that the tube is locked to the port. Do not twist and turn. To take the tube 
out of the port, push the Outer Flap in against the Inner Flap, and while 
doing this, pull out the tube. This will cause the gripping mechanism to 
release from the tube.  

Wavelength Monitor Purge 

Why do the Picarro isotopic water analyzers (L21x0-i) have a 
wavelength monitor (WLM) purge?  

The WLM purge acts to fill the warm box of your analyzer with dry gas. The 
warm box houses the WLM which is part of the analyzer’s laser targeting 
control loop. The WLM itself enables us to precisely control the wavelength 
of light being injected into the cavity. Within the warm box there is a 
distance of about 10 cm which is open path, i.e., the laser light is seeing 
the ambient atmosphere at 45°C (the temperature at which the warm box 
is held). Because water is such a strong absorber, and in the case of our 
isotopic water systems, the laser is specifically tuned to a frequency of 
water absorption, this open path segment may result in decay of the light 
prior to entering the WLM. As a result, the performance of the WLM could 
vary as ambient conditions change. We elect to dry the gas seen by the 
laser in the warm box such that any potential decay due to water 
absorption is limited.  

Should I always have dry gas purging the WLM or can I leave it open? 

At ambient temperature and pressure, drying the gas that enters the WLM 
is not essential, but we do recommend it. If you have access to a zero air 
or N2 tank, such as the tank being used as the dry gas source for your 
vaporizer (High Precision or High Throughput Vaporizer), we recommend 
adding a T to the line and feeding both your vaporizer and WLM purge with 
the same dry gas source. You can also purchase a dry gas kit from us with 
the necessary regulator and fittings to connect a N2 tank (part # A0921) or 
zero air tank (part # A0923) to your system. If you are operating your 
analyzer in a very humid environment, such as above 3% water content 
(30,000 ppm), we always recommend dry gas be supplied to your WLM 
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purge. Without this dry gas supply, you may experience more drift in the 
analyzer.  

Does the gas used for the WLM purge need to be the same as matrix 
gas for the cavity? 

No, the gas that is used to purge the WLM can differ from the matrix gas 
seen by the cavity. Picarro isotopic water analyzers have two modes of 
operation; air and N2 (use the “Picarro Mode Switcher” to switch between 
the two). If, for example, you are using the SDM and operating in air mode, 
you can use N2 to purge the WLM. The opposite is also fine. If you’re 
running from a tank, you’ll typically use the same gas for convenience.  
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9. VAPORIZER TO ANALYZER CONNECTIONS 

Valve Controller Cable 

Attach the 15 pin end of the grey valve cable to the port labelled Vap 
Valves on the vaporizer and connect to the port labelled VALVES on the 
analyzer (third connector from the left at the bottom row of the Analyzer). 

Gas Line 

1. Carefully align the analyzer and the autosampler relative to each 
other such that the gas delivery line hanging from the vaporizer is 
aligned with the inlet port of analyzer. Do not bend the delivery port 
in the process. If the delivery port is not horizontally aligned with the 
analyzer inlet port, gently move the position of the vaporizer on the 
autosampler by loosening the clamps and retightening them after 
alignment.  

2. Follow the images below to connect the gas line from the vaporizer 
to the analyzer. Once the vaporizer is connected to the analyzer, 
carefully push the autosampler and vaporizer forward so that there 
is no gap between the insulation around the vaporizer outlet and the 
analyzer.  

Figure 21: 
Type 

description 
here 
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Figure 22: 
Type 

description 
here 
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10. BASIC OPERATION 

10.1 Start Up 

Picarro Analyzers are designed to start up upon receiving mains power. 
First, make sure the basic analyzer hardware was installed per the 
instructions in this manual. 

Figure 
23: 

Analyzer 
Setup 

 
The CRDS analyzer and the Vaporizer each have a vacuum pump. Make 
sure that the vacuum pump being installed is for the CRDS analyzer. 

The exhaust port of the External Vacuum Pump will have a muffler 
attached for noise reduction. 

Once the hardware is installed the mains power switch can be turned to 
ON (O/I switch on rear of analyzer should be depressed to position “I”). At 
this point, the computer and CRDS software will start up automatically. The 
following status window will demonstrate that the CRDS software is 
loading.  



 
 

 

L21x0-i Inst/Op Manual P/N 40035 Rev. F 53 

Figure 24: 
Startup; 

Software 
Loading 

Sequence 

 

Once the CRDS software has been launched, the Analyzer will move 
towards obtaining its highly controlled temperature and pressure set points. 
In the case of the water analyzer, these are 80°C and 50 Torr. Warm up 
typically takes about one hour. By design, the cavity pressure will not start 
to decrease until the cavity temperature is close to its set point. Ideally, the 
Analyzer is open to room air during the warm up, i.e., there is nothing 
attached to the “Gas Inlet” on the rear of the Analyzer. This is desired 
because ambient water vapor will provide a good signal for the Picarro 
Wavelength Monitor (WLM) which provides the frequency control for the 
spectral measurement.  

If the Analyzer is without a signal for a long period of time (i.e., it is left on 
dry gas for multiple hours to days), the frequency axis of the Analyzer can 
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get lost resulting in incomplete spectra. If you notice an increase in 
measurement interval or data drop outs after a period of idle time on dry 
gas, simply disconnect or turn off your dry gas source. The instrument will 
stabilize after a period of measuring room air.  

10.2 Shut Down 

Before proceeding to turn off the analyzer, note the following warnings. 

 
CAUTION 

Equipment Damage: A flow of clean, relatively dry gas should 
always be directed through the instrument for several minutes prior 
to shut down. Trapping a high-moisture content gas sample in the 
cavity can cause condensation damage to the mirrors as the 
instrument cools from its operating temperature. 

 

 
CAUTION 

FOR ALL USERS: Do not turn off the pump or disconnect the 
vacuum line while the instrument is operating. 

 

 
CAUTION 

FOR G2000 SERIES ANALYZER USERS: If you have trouble turning 
off the analyzer software, do not kill process(es) in the task 
manager. Instead, double-click on the "Stop Instrument" icon in the 
“Diagnostics” folder on your desktop. 

 

 
CAUTION 

Equipment Damage: If you accidentally over-saturate the 
instrument with water, it is very important that you do not turn the 
instrument off. Instead, let the instrument pull either room air or dry 
air/N2 through for a few days to dry out the cavity - until the 
instrument can make measurements normally again. If the 
instrument is turned off right after the accident, water will 
condense and contaminate the cavity rendering it useless. The 
cavity repair can cost up to $25,000 (USD). 

To shut down the analyzer using the GUI: 

1. Click on the “Shutdown” button located on the left side of the Data 
Viewer window.  



 
 

 

L21x0-i Inst/Op Manual P/N 40035 Rev. F 55 

2. A window will pop-up (Figure 24) prompting the user to confirm the 
shutdown. Once confirmed, the analyzer software and hardware 
will turn off.  

3. Manually turn off the pump(s) and dry gas (only if your system 
requires it). 

10.3 In case of an electrical power outage 

If power to the analyzer is cut off for any reason, the analyzer will cease 
operation. When the power is reapplied, the analyzer will restart 
automatically. The Picarro software tools will close out previous files and 
open new files for data collection so that previously collected data, 

Figure 25: 
Shutdown 

Dialog 
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instrument diagnostics and other parameters recorded up to the time of 
power outage are retained. The Analyzer will not restart any active 
Coordinators that were operating before the power outage.  

If short power outages will be a routine operating environment, Picarro 
recommends the use of a power conditioning and/or uninterrupted power 
supply (UPS) that will work to prevent the more damaging operating 
system and software corruption problems that can occur with repeated 
crashes.  

10.4 Dual Mode Setup 

Dual mode is used for measurement of ambient vapor coupled with 
automated injection of liquid calibration standards. This setup requires 
A0211 High Precision Vaporizer, A0912 Dual Mode Configuration 
hardware and software for vapor calibration, and an Autosampler. Each 
injection cycle takes 9 minutes. 

OPERATION 

1. Before continuing, review the important safety notes in the SAFETY 
section.  

2. Make sure the hardware setup is complete and the system turned 
on in the correct sequence. 

3. Once turned on, the main CRDS Data Viewer of the analyzer will 
open automatically on the desktop screen. To understand all the 
functions of the main CRDS Data Viewer, see CRDS Data Viewer. 
A sequence of start-up messages will also appear in the Status Log 
Message window of the main CRDS Data Viewer. For definition, see 
Common Status Log Messages. 

4. Make sure the temperature of the High Precision Vaporizer 
stabilizes at 110°C by viewing the read out on the front of the 
vaporizer.  
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Before starting measurements, ensure you are in the correct 
measurement mode. Select the measurement mode that matches 
the dry gas supplied to your Vaporizer (either N2 or zero air). See 
section Switching between Measurement Modes for instructions. 

5. Make sure the Picarro Autosampler software is running, that the 
Autosampler has been trained, methods and jobs defined, and 
samples loaded. Refer to the  Picarro A0325 Autosampler User 
Manual (PN 40025) for detailed setup instructions. 

6. Double click on the Coordinator Launcher icon on the analyzer’s 
desktop. The coordinator software allows the analyzer to take 
measurements from multiple samples and is used to control the 
sample source and match the corresponding real time read out with 
the sample source. To learn more about the coordinator software 
(running the software, loading sample description, functions of the 
coordinator window), see Coordinator Software. Choose and 
launch an appropriate coordinator mode from the choices in the 
drop down menu of the coordinator launcher window. The Dual 
Mode Setup can operate in one coordinator mode.  

7. Once launched, before the Coordinator window opens up, the User 
Editable Parameters window will pop up (as shown below): 

Figure 26: 
User Editable 

Paramters 
Window 

 

This allows measurement of liquid isotopic water standards at fixed 
time intervals during the measurement of the vapor phase to verify 
calibration. The analyzer will run the parameters specified in a 
continuous loop until exiting from the program (i.e., measure 5 liquid 
injections, 1 hour of vapor, 5 liquid injections, 1 hour of vapor, etc.). 
Measurement will always start with liquid injections.  

 If no liquid samples are to be measured then enter ‘0’ in 
the field for liquids. It will then measure the vapor 
continuously. 

 If no vapor samples are to be measured then enter ‘0’ in 
the field for vapors. It will then run only the liquid samples 
specified in the Autosampler job (see later section for 
details). 
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 If the analyzer is already running and these parameters 
need to be changed it will require exiting and restarting 
the Picarro coordinator software. 

 

Analysis of liquid samples requires that both the coordinator 
software and autosampler job be started. Be sure to start the 
Autosampler Controller software before launching the Dual Mode 
Coordinator. Once the Autosampler Controller software is open, 
you may start the Dual Mode Coordinator. Once open, click “Run” 
on the Autosampler Controller software. 

Picarro highly recommends matching the “Number of liquid 
injections for calibration” to the injection count set in the 
Autosampler job. This ensures one sample vial is analyzed completely 
before returning to vapor measurements. If two or more liquid calibration 
standards are used then “number of liquid injections for calibration” can 
also be an integer multiple of the injection count set in the Autosampler job.  

For example, if eight injections each of two liquid standards are to be run 
every 6 hours during vapor measurements then enter 16 (8 injections * 2 
standards) in the first field and 6 in the second field. 

Be sure there are sufficient liquid standards available because once all the 
liquid samples specified in the Autosampler job have been run and the 
current vapor measurement is complete, the analyzer will wait indefinitely 
or until a new Autosampler job is started.  

 

To calculate the time to complete the autosampler job use the 
follow formula: 

Cycle time = number injections * 9 min + vapor measurement time 

Assuming 1 standard per cycle, 8 injections, and 6 hours vapor 
measurement: the total cycle time is 432 minutes and consumes 1 vial. 
The Picarro Autosampler has a tray for up to 105 vials. Therefore, one full 
tray of 105 vials will last 432 * 105 = 45360 minutes or 31.5 days. Thus, 
plan on one tray lasting for one month of measurements when calibrating 
every 6 hours. 

Once the injection number and vapor measurement duration parameters 
have been entered, and the ‘OK’ button is clicked, the coordinator window 
will pop up on your desktop. The different software element will indicate 
whether liquid or vapor is being measured.  
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8. Once launched, the coordinator will automatically start collecting 
data. The data will also be available in the GUI as pulses. To 
customize pulse analysis or to adjust the peak of pulse data, please 
see Pulse Customization. 

Figure 27: 
Coordiator 
Launcher 

 

 

Coordinator Launcher Window  

 

Coordinator Window 

DATA 

To learn where to retrieve the data, and to set the frequency of file archival 
and automatic deletion of old files, see Data Files. To access one’s data 
remotely, see the section, REMOTE DATA ACCESS.  

To configure data file saving details, including which data elements are 
written to data files, digital data output (via serial port or TCP/IP), remote 
data delivery (via email), and general GUI properties, click on the Setup 
Tool icon in the Picarro Utilities folder in the desktop.  

The Picarro Water Analyzers allow users to archive data using a 
compressed, binary “HDF5” or “h5” format. THE DATA FILE VIEWER 
program, which comes installed with the hardware, allows one to open and 
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convert h5 files, as well as viewing the h5 files as graphs. For more 
information, see THE DATA FILE VIEWER.  

The Picarro Water Analyzers come preinstalled with the ChemCorrect 
software which allows one to screen and quantify contamination in isotopic 
water samples. To post process data using ChemCorrect Software, see 
ChemCorrect Software: Analysis of Coordinator Files.  

One many need to adjust the sample injection volume to improve the 
quality of one’s data. See Adjusting Injection Volume for more 
information. 

10.5 Manual Mode Setup 

OPERATION 

1. Before continuing, review the important safety notes in SAFETY.  

2. Make sure the hardware setup is complete and the system turned 
on in the correct sequence.  

3. Once turned on, the main CRDS Data Viewer of the analyzer will 
open automatically on the desktop screen. To understand all the 
functions of the main CRDS Data Viewer, see CRDS Data Viewer. 
A sequence of start-up messages will also appear in the Status Log 
Message window of the main CRDS Data Viewer. For definition, see 
Common Status Log Messages. 

4. Make sure the temperature of the High Precision Vaporizer has 
stabilized to 110 °C. 

 

Before starting measurements, ensure you are in the correct 
measurement mode. Select the measurement mode that matches 
the dry gas supplied to your Vaporizer (either N2 or zero air). See 
section Switching between Measurement Modes for instructions. 

5. Double click on the Coordinator Launcher icon on the desktop. The 
coordinator software allows the analyzer to take measurement from 
multiple samples and is used to control the sample source and 
match the corresponding real time read out with the sample source. 
To learn more about the coordinator software (running the software, 
loading sample description, functions of the coordinator window), 
see Coordinator Software. Choose and launch an appropriate 
coordinator mode from the choices in the drop down menu. The 
coordinator window will pop up.  
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The Manual Mode Setup can operate in one coordinator mode in 
the L2130-i.  

 Manual Inject: Used for semi-automated measurement of 
liquid water samples with high precision. Requires A0211 High 
Precision Vaporizer and A0322 Syringe Guide. User manually 
injects samples after prompt. The vaporizer control and the 
analysis of liquid samples are automated. Each injection cycle 
takes 9 minutes.  

The Manual Mode Setup can operate in two coordinator modes for 
the L2140-i.  

 O17 Manual Inject: Used for semi-automated measurement of 
liquid water samples for δ18O, δ17O, δD and 17O-excess. 
Requires A0211 High Precision Vaporizer and A0322 Syringe 
Guide. User manually injects samples after prompt. The 
vaporizer control and the analysis of liquid samples are 
automated. This coordinator must be run in either the “iH2O N2 
O-17” mode or the “iH2O Air O-17” mode. In this mode the 
coordinator will output δ17O and 17O-excess. Each injection 
cycle takes 9 minutes.  

 Manual Inject: Used for semi-automated measurement of 
liquid water samples with high precision on δ18O and δD. 
Requires A0211 high precision vaporizer and A0322 Syringe 
Guide. User manually injects samples after prompt. The 
vaporizer control and the analysis of liquid samples are 
automated. Each injection cycle takes 9 minutes.  

To learn about all the other coordinator modes supported by the Picarro 
water analyzer (in different setups), see Coordinator Modes Available On 
a Picarro Water Isotope Analyzer.  

6. Once launched, the coordinator will direct the user on when to 
manually inject samples and it will automatically start collecting data. 
The data will also be available in the GUI as pulses. To customize 
pulse analysis or to adjust the peak of one’s data pulses, see Pulse 
Customization.  

7. The status bars at the bottom of the Coordinator window will allow 
one to know if the analyzer is ready for a manual injection or not. If 
ready, the sample description (if preloaded) will appear. If not 
loaded, a description can be added. Manually inject the sample and 
then press the Injected button in the lower right corner of the 
Coordinator window. The coordinator software will prepare the 
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sample in the vaporizer in high precision mode. It will take 
approximately 9 minutes until it is ready for the next injection.   

DATA 

To learn about different types of data produced by one’s system and to set 
file archival and automatic deletion of old files, see Data Files. To access 
one’s data remotely, see REMOTE DATA ACCESS. 

The Picarro Water analyzers allow users to archive data using a 
compressed, binary “HDF5” or “h5” format. The Data File Viewer program, 
which comes installed with the hardware allows one to open and convert 
h5 files, as well as viewing the h5 files as graphs. For more information, 
see THE DATA FILE VIEWER.  

The Picarro Water Analyzers come preinstalled with the ChemCorrect 
software which allows one to screen and quantify contamination in isotopic 
water samples. To post process data using ChemCorrect Software, see 
ChemCorrect Software: Analysis of Coordinator Files.  

One many need to adjust the sample injection volume to improve the 
quality of data. See Adjusting Injection Volume for more information.  

10.6 Picarro Autosampler and High Precision Vaporizer 
Setup 

OPERATION 

1. Before continuing, review the important safety notes in SAFETY.  

2. Make sure the hardware setup is complete and the system is turned 
on in the correct sequence.  

3. Once turned on, the main CRDS Data Viewer of the analyzer will 
open automatically on the desktop screen. To understand all the 
functions of the main CRDS Data Viewer, see CRDS Data Viewer. 
A sequence of start-up messages will also appear in the Status Log 
Message window of the main CRDS Data Viewer. For definition, see 
Common Status Log Messages. 

4. Make sure the temperature of the High Precision Vaporizer has 
stabilized at 110°C by viewing the read out on the front of the 
vaporizer.  

 

Before starting measurements, ensure you are in the correct 
measurement mode. Select the measurement mode that matches the dry 
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gas supplied to your Vaporizer (either N2 or zero air). See section 
Switching between Measurement Modes for instructions. 

5. Make sure the Picarro Autosampler software is running, that the 
Autosampler has been trained, methods and jobs defined, and 
samples loaded. See A0325 Autosampler User Manual (PN 
40025.  

6. Double click on the Coordinator Launcher icon in the analyzer’s 
desktop. The coordinator software allows the analyzer to take 
measurements from multiple samples and is used to control the 
sample source and match the corresponding real time read out with 
the sample source. To learn more about the coordinator software 
(running the software, loading sample description, functions of the 
coordinator window), see Coordinator Software. Choose and 
launch an appropriate coordinator mode from the choices in the 
drop down menu of the coordinator launcher window. The 
coordinator window will pop up.  

The Picarro Autosampler – High Precision Vaporizer Setup can 
operate in following coordinator modes:  

For the L2140-i: 

 High Precision: For interfacing with an autosampler for 
highest precision measurements of δ18O and δ2H. This 
coordinator must be run in either the iH2O N2 mode or the 
iH2O Air mode. In this mode the coordinator will not output 
δ17O and 17O-excess. Each injection cycle takes 9 minutes. 

 High Throughput: For interfacing with an autosampler for 
faster measurements of δ18O and δ2H with good precision. 
This coordinator must be run in either the iH2O N2 mode or the 
iH2O Air mode. In this mode the coordinator will not output 
δ17O and 17O-excess. Each injection cycle takes 4 minutes.  

 O17 High Precision: For interfacing with an autosampler for 
highest precision measurements of δ18O, δ17O, δD and 17O-
excess. This coordinator must be run in either the “iH2O N2 O-
17” mode or the “iH2O Air O-17” mode. In this mode the 
coordinator will output  δ17O and 17O-excess. 

 Express*: Used for faster measurement of liquid water 
samples with good precision. This coordinator must be run in 
either the “iH2O N2” mode or the “iH2O Air” mode. 
Automatically injects and analyzes liquid water samples. when 
using the Express coordinator, we recommend 10 injections, 
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the first 6 injections take 1.5 minutes each, while the last 4 
injections take 5 minutes each. The first 7 injections will be 
discarded to achieve the optimal memory reduction.  

 Standard*: Used to measure liquid water samples with 
maximum precision. This coordinator must be run in either the 
“iH2O N2” mode or the “iH2O Air” mode. Automatically injects 
and analyzes liquid samples. Each injection cycle takes 9 
minutes. 

 Survey*: Used for super-fast measurements of large sample 
batches at moderate precision and enables an efficient sample 
sorting. Automatically injects and measures liquid samples. 
This coordinator must be run in either the “iH2O N2” mode or 
the “iH2O Air” mode.  

Survey mode has two use cases: 

1. Sample Sorting and Rearrangement: Survey large 
sample batches and use the output values to manually 
rearrange samples. This will result in reducing the 
memory effect of followed measurements (either by 
Express mode or by Standard mode). In this use case 
we recommend doing 1 injection per sample, with 
sample volume of 2.5 µl. Using these parameters, 
measurement time is 95 seconds per sample. 

2. Sample Measurement with Moderate Precision: Use 
the survey mode to quickly measure samples with 
moderate precision. Here we recommend 6 injections 
with sample volume of 2.5 µl. The first 3 injections 
should be discarded to achieve the acceptable levels of 
memory. Using these parameters, measurement time is 
reduced to 9.5 minutes per sample.  

*only available with Coordinator software upgrade 
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For the L2130-i:  

 High Precision: Used to measure liquid water samples with 
maximum precision. This coordinator must be run in either the 
“iH2O N2” mode or the “iH2O Air” mode. Automatically injects 
and analyzes liquid samples. Each injection cycle takes 9 
minutes. 

 High Throughput: Used for faster measurement of liquid 
water samples with good precision. This coordinator must be 
run in either the “iH2O N2” mode or the “iH2O Air” mode. 
Automatically injects and analyzes liquid water samples. Each 
injection cycle takes 4 minutes.  

 Express*: Used for faster measurement of liquid water 
samples with good precision. This coordinator must be run in 
either the “iH2O N2” mode or the “iH2O Air” mode. 
Automatically injects and analyzes liquid water samples. when 
using the Express coordinator, we recommend 10 injections, 
the first 6 injections take 1.5 minutes each, while the last 4 
injections take 5 minutes each. The first 7 injections will be 
discarded to achieve the optimal memory reduction.  

 Standard*: Used to measure liquid water samples with 
maximum precision. This coordinator must be run in either the 
“iH2O N2” mode or the “iH2O Air” mode. Automatically injects 
and analyzes liquid samples. Each injection cycle takes 9 
minutes. 

 Survey*: Used for super-fast measurements of large sample 
batches at moderate precision and enables an efficient sample 
sorting. Automatically injects and measures liquid samples. 
This coordinator must be run in either the “iH2O N2” mode or 
the “iH2O Air” mode.  

Survey mode has two use cases: 

1. Sample Sorting and Rearrangement: Survey large 
sample batches and use the output values to manually 
rearrange samples. This will result in reducing the 
memory effect of followed measurements (either by 
Express mode or by Standard mode). In this use case 
we recommend doing 1 injection per sample, with 
sample volume of 2.5 µl. Using these parameters, 
measurement time is 95 seconds per sample. 
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2. Sample Measurement with Moderate Precision: Use 
the survey mode to quickly measure samples with 
moderate precision. Here we recommend 6 injections 
with sample volume of 2.5 µl. The first 3 injections 
should be discarded to achieve the acceptable levels of 
memory. Using these parameters, measurement time is 
reduced to 9.5 minutes per sample.  

*only available with Coordinator software upgrade 

 

 

Analysis of liquid samples requires that both the coordinator software and 
autosampler job be started. Be sure to start the Autosampler Controller 
software before launching the Dual Mode Coordinator. Once the 
Autosampler Controller software is open, you may start the Coordinator. 
Once open, click “Run” on the Autosampler Controller software. 

7. Once launched, the coordinator will automatically start collecting 
data, assuming the Autosampler job has been started. The data will 
also be available in the GUI as pulses. To customize pulse analysis 
or to adjust the peak of pulse data, please see Pulse 
Customization. 

Figure 28: 
Coordinator 

Launcher 

 

 

Coordinator Launcher Window for the L2140-i  
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Figure 29: 
Coordinator 

Window 

 

 

DATA 

To learn where to retrieve the data from, and to set the frequency of file 
archival and automatic deletion of old files, see Data Files. To access 
one’s data remotely, see REMOTE DATA ACCESS.  

To configure data file saving details, including which data elements are 
written to data files, digital data output (via serial port or TCP/IP), remote 
data delivery (via email), and general GUI properties, click on the Setup 
Tool icon in the Picarro Utilities folder in the desktop.  

The Picarro Water analyzers allow users to archive data using a 
compressed, binary “HDF5” or “h5” format. The Data File Viewer program, 
which comes installed with the hardware, allows one to open and convert 
h5 files, as well as viewing the h5 files as graphs. For more information, 
see THE DATA FILE VIEWER.  

The Picarro Water Analyzers come preinstalled with the ChemCorrect 
software which allows one to screen and quantify contamination in isotopic 
water samples. To post process data using ChemCorrect Software, see 
ChemCorrect Software: Analysis of Coordinator Files.  

One many need to adjust the sample injection volume to improve the 
quality of one’s data. See Adjusting Injection Volume for more 
information. 
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10.7 Picarro Autosampler and High Throughput Vaporizer 
Setup 

Picarro removed the High Throughput Vaporizer (part number A0212) from 
the price list in December 2013. Since that time, we have not shipped new 
High Throughput Vaporizers; however, we do continue to support High 
Throughput Vaporizers that are in the field. If you own a High Throughput 
Vaporizer, please contact support@picarro.com for operational 
instructions. They will refer you to an older version of this manual.  
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11. PICARRO SOFTWARE 

11.1 Desktop Icons and Folders 

On the Window’s desktop, the following icons and folders may be present. 
The options available will vary depending on the configuration of your 
analyzer.  

1. Start Instrument: When clicked, the analyzer will start measuring in 
the configuration that it was last in when the software/analyzer was 
shut down.  

2. Coordinator Launcher: Depending on the system’s 
configuration, the coordinator program may or may not be 
included. Clicking on this icon will lead you to a window which will 
allow you to select the appropriate mode for coordinator output, for 
example using the high precision vaporizer or the standards delivery 
module. 

3. Picarro Mode Switcher: Depending on the system’s 
configuration, the Mode Switcher Software may or may not be 
included. When clicked, you will be led to a window which will allow 
you to switch between various measurement modes. For the L2140-
i this is how you switch between the normal mode for measuring 
only  δ18O and  δD, and the 17O mode for measuring  δ18O,  δ17O,  
δD and 17O-excess. For all water isotope analyzers, this is how you 
switch between measuring water in an air or pure nitrogen matrix.  

4. Picarro Controller: When clicked, you will be led to a useful 
diagnostic panel allowing the user to see the analyzer’s internal 
temperatures, pressure, and spectroscopy in real time. This 
program has user-accessible functions, but certain aspects are 
password protected to avoid inadvertent changes related to 
analyzer functionality. Password protested functionalities are 
intended for diagnostics purposes only and should only be accessed 
by members of Picarro’s Technical Support Team.  

5. Picarro Utilities Folder:  

 THE DATA FILE VIEWER: When clicked, you will be led to 
a window which will allow you to convert between *.dat 
and H5 data files and to make various graphical 
representations of your data.  

 Data Recal: When clicked, you will be led to a window 
which will allow you to recalibrate your data based on 
known, certified data.  
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 Setup Tools: When clicked, you will be led to a window 
which will allow you to edit various settings for your 
analyzer (See the “Setup Tools” in the Desktop Icons and 
Folders section of this manual).  

6. PostProcess ChemCorrect: The ChemCorrect software is now 
included on all Picarro water isotope analyzers. The software allows 
post acquisition analysis of discrete sample data generated by the 
coordinator. See section entitled ChemCorrect Software.  

7. Diagnostic Folder 

 Stop Instrument: When clicked, you will be led to a 
window (see below) which will allow you to turn off the 
analyzer in an emergency event. Upon clicking on this 
icon, the following window will pop up. Please see the 
Shutdown section of this manual to shut down the 
analyzer in normal circumstances.  

Figure 30: 
Stop CRDS 

Window 

 

11.2 Switching Between Measurement Modes 

1. The Picarro Mode Switcher allows users to operate the analyzer in 
various modes. Switching between measurement modes is 
accomplished with a few easy steps: 

2. Activate the user interface by double-clicking the Picarro Mode 
Switcher icon on the desktop. 

3. To switch modes, click the drop-down menu, select the desired 
measurement mode, and then click the launch button.  
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Figure 31: 
Picarro Mode 

Switcher 

 

 

Figure 32: 
Restart CRDS 

Confirmation 

 

4. Confirm your selection when prompted by the confirmation dialog 
box. 

5. The analyzer software will then re-start in the new measurement 
mode. There is no need to turn off the vacuum pump or any other 
peripherals during this process.  
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11.3 CRDS Data Viewer 

The Picarro analyzer GUI has many features. See below for more 
information.  

Figure 
33: 

Data 
Viewer 
Layout 

 

Layout of the Picarro CRDS Data Viewer. Types of data shown in the 
main GUI will differ between different analyzer configurations. 

Settings, Tools and Help Menus 

 Settings Menu 

Left clicking on the Settings menu pulls down a menu that has one 
entry: Change GUI Mode from Standard to Service. This is the 
access point to a password protected service mode where 
additional operational and measurement parameters are displayed. 
Selecting and clicking on this entry opens the Cavity Ring-Down 
Spectrometer Controller. This is reserved for Picarro service 
operators only. 

 View Menu 

This menu item has three entries: 

 Lock/Unlock time axis when zoomed: When locked, forces the 
two graphs to display the same time scale during zoom. 
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 Show/hide statistics: Toggles the measurement statistics 
display, see Digital Readout section below. 

 Show/hide instrument status: Toggles the instruments status 
display. See Instrument Status section below. 

 Tools Menu 

This menu item has one entry: 

 User Calibration: Opens the user calibration window (default 
password is “picarro”). The calibration slope and intercept can 
be entered and their effects immediately seen in the data. 
Please refer to the Calibration section of this manual to learn 
more. The password can be reset in the QuickGui.ini file in the 
instrument directory: “C:\Picarro\G2000\AppConfig 
\Config\QuickGUI\” under the section: [Authorization] 
UserCalPassword = Picarro Show/Hide Valve.  

 Help Menu 

“About” displays the version number of the instrument. 

Alarm Panel 

The panel in the upper left-hand corner of the GUI is used to monitor the 
status of the internal instrument alarms. These indicators are gas 
concentration alarms (i.e., “CO2 Too High/Low”). The gas concentration 
alarm LEDs are off (grayed out) when the respective concentrations are 
below a certain value, and they are illuminated when the respective 
concentrations are above/below a certain value. 

To view the alarm set point, click on the LED and a dialog box will appear, 
indicating the alarm setting. The user can either enable the alarm or 
change the set point. 
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Figure 34: 
Alarm Settings 

Dialog 

 

To change the set point, type the value you wish to set the alarm to and 
click the “OK” button to confirm. If you do not wish to change the alarm 
value anymore, press “cancel.” If you do nothing, the dialog box will 
eventually disappear, and the alarm value will remain unchanged. 

Digital Readouts 

Displays the latest value recorded for the selected Data Key for each Data 
Window. Changing the Data Key changes the Digital Readout as well as 
changes the Data Window view. If the ‘Show Statistics’ entry is enabled in 
the ‘View’ menu, the mean, standard deviation and slope of the data in the 
graph is dynamically calculated and indicated below the digital 
concentration readout. These numbers change to reflect statistics of 
whatever data is in the data window. 

Start / Stop Data Log Button 

The Analyzer automatically records all data collected on the instrument and 
saves it for later analysis. These files are called Data.dat files, which are 
described below in the section called “File Management”. In addition, the 
user can record a separate data log file. Press this button if you would like 
the instrument to start recording a separate data file. A dialog box will 
appear prompting you for a filename and location. Press this button again 
to stop recording the data file. 

Data Log Filename and Path 

The filename and path of the active data log is displayed in this pane. The 
indicator is grayed-out if there is no active data log (i.e., if a new data log 
has not been started using the Start /Stop New Data Log Button). A new 
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file will be generated at midnight, which will be saved to the same location 
as the original log file. 

Data Window 

The data window displays a graph of any stream of data vs. the computer’s 
system time, with a format of hh:mm:ss. The user can select which data 
stream are displayed using combinations from the Data Source and Data 
Key pull down menus. The precision displayed can be adjusted using the 
“Precision” menu and Auto-scaling of the ‘Y’ axis is also available. 

Instrument Status 

If these parameters are enabled through the ‘Show Instrument Status’ 
entry in the ‘View’ Menu on the main toolbar digital readouts for Warm Box 
temperature, Cavity Temperature and Cavity Pressure are displayed to the 
left of the main trend graphs. 

Data Source and Data Key Pull Down Menus 

These two menus enable selection of the data stream that is viewed in the 
data window. Data streams available on the GUI are gas concentrations, if 
‘instrument Analysis’ (where instrument represents the system installed) is 
selected, or if “sensors” is selected, the analyzer’s optical cavity pressure 
or temperature can be viewed as well as the nominal ambient temperature 
of the analyzer (“DAS temp”) and the temperature of the analyzer’s 
wavelength monitor, indicated as “warm box temp.”  

 

The “DAS temp” sensor is located on the main electronics board. It is 
commonly 5-10°C above ambient temperature. 

Precision Pulldown Menu 

Click on this icon to select the precision displayed on the y-axis, between 0 
and 4 digits of precision or “auto”. The currently selected precision is 
displayed during operation. This does not affect the precision of the saved 
data in the data log files or results files. 

Status Log Window 

This window displays instrument status messages, in the following form: 
“MM/DD/YYYY hh:mm:ss generic message text.” These messages include 
all messages sent to the front panel display. 
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Reset Data Buffer Button 

Press this button to clear the internal data buffer of the GUI (this clears the 
current data traces from the graphs). This has the effect of clearing all data 
in the data window. Pressing this button has no effect on any of the data 
log files stored by the instrument. 

Data Buffer Level Meter 

The meter to the right of the Data Window indicates how much of the 
internal memory of the GUI is used to retain historical data collected with 
the instrument. There is an internal limit of a finite number of points. Once 
that number of data points is collected, the buffer is full, and old data is 
removed from the buffer as new data is collected. This buffer affects only 
the data displayed in the data window, not the data stored in any files. This 
buffer is empty upon instrument startup and can also be emptied by 
pressing the reset data buffer button in the lower-right-hand corner of the 
GUI. 

Graph Zooming 

To zoom the graph, simply drag the magnifying glass over the section to be 
zoomed and click and hold the left mouse button. While holding down the 
left button, move the mouse to create a box that covers the region of 
interest. When the box is properly drawn, release the left button and boxed 
area will automatically scale to fill the data window. To zoom back out, 
double click on the left button. To autoscale the y-axis of either graph, use 
the autoscale buttons below the graph. To lock or unlock the time axes of 
each graph during zooming, select that menu item in the ‘View’ menu. 

Common Status Log Messages 

Temperature Locked: WB/HB (normal startup) 

The system waits for the warm box (“WB” – the wavelength monitor 
chamber) to reach operating temperature. Similarly, the temperature of the 
hot box (“HB” – the chamber containing the analyzer’s optical cavity and 
gas handling system) is stabilized. This is typically the longest step in the 
startup sequence. The duration of this step can range from 5 to 60 
minutes, depending on the ambient temperature and how much time has 
elapsed since the last startup. 
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Entering Measurement (normal startup) 

Spectral scanning has started. Concentration measurements will be 
available in approximately 30 seconds. The instrument will continue to 
scan and report concentration measurements until the instrument is 
shutdown using the procedure below. 

Pressure Stabilizing/Locked (normal startup) 

The valve control system begins to allow flow through the analyzer and 
stabilizes the pressure inside the cavity. 

Measuring (normal startup) 

This is the normal mode of operation after startup has completed. 

Pressure High – check vacuum pump (error) 

There is unusually high pressure. The pump is either weak or dying or the 
vacuum hose has a leak. See Troubleshooting section.  

11.4 Coordinator Software 

In order to measure discrete samples or to control external peripherals and 
accessories a separate software tool (Coordinator) is used to control the 
sample source and match the corresponding real time read out with the 
sample source. The Coordinator programs that are accessible to a 
user, are dependent on the system configuration.  

 

 Although this section will provide an overview to the concept of 
Coordinators, it does not necessarily provide the detail on all 
Coordinators available on a Picarro water isotope system. Instead, refer 
to the separate User Manual provided with your Picarro accessories, for 
example: 

 SDM User Manual 

 IM User Manual 

 MCM User Manual 

 CWS User Manual 

How to Run Coordinator Software: 

1. First, make the required hardware connections for your system of 
interest. Afterwards, turn on the analyzer and wait for the CRDS 
Data Viewer of the analyzer’s software to open up automatically on 
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your desktop screen. Next, launch the coordinator software by 
double clicking on the ‘Coordinator Launcher’ icon on your desktop. 

2. After double clicking on the ‘Coordinator Launcher’ icon, a window 
will appear. Choose the appropriate coordinator from the drop down 
menu, and then click on the ‘Launch’ button. Make sure that the 
chosen coordinator is supported by your hardware connections and 
that samples are ready to be analyzed.  

Figure 35: 
Coordinator 

Launcher 
and 

Window 

 

 

 

Coordinator window. The look of the window may vary 
depending on the configuration of your analyzer. 

3. After clicking on the “Launch” button, the coordinator window will 
pop up (depending on the coordinator mode chosen, you may or 
may not be asked to set parameters for your analysis). From the 
Coordinator window, you will be able see results from sample 
analysis, see the current status of your analyzer, and load sample 
descriptions. 
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Figure 36: 
Coordinator 

Window 
Description 

 

Coordinator Window Descriptions 

1. Change Septum Button: Used to pause the Autosampler and the 
vaporizer in the middle of an analysis to physically change the 
septum on the vaporizer.  

2. Load Sample Descriptions Button: Located around the upper 
right corner of the Coordinator Window. The button allows the user 
to include a description for each vial in the data file output on the 
coordinator window. 

In order to load the sample description file, press the button labeled 
‘Load Sample Descriptions’. If you are using the CTC PAL 
Autosampler, two file dialog boxes will appear in sequence, the first 
for the front tray and the second for the rear tray. For the Picarro 
Autosampler, only one dialog box will appear. Select the sample 
description file, and then click to ‘Open’. If a certain tray (front or 
rear) is not being used, use the ‘Cancel’ button to dismiss the dialog.  

3. New Output File Button: Clicking on this button will save the data 
that you see on the coordinator window into a file, and then clear the 
data from the Coordinator Window.  

4. Upper Portion of The Window: Each row represents the analysis 
results from a single injection. The types of columns are pre-
selected by Picarro to include the most useful values for isotopic 
water analysis and for diagnostic indications. 

Load Sample 
Descriptions 

New 
Output File 

Coordinator 
Output Filename 

Upper 
Portion of 
Window 

Lower 
Portion of 
Window 

Change 
Septum 



 
 

 

80 P/N 40035 Rev. F L21x0-i Inst/Op Manual 

The values for the columns, unless otherwise noted, are the 
average value for time period of the injection, which was marked in 
red on the CRDS Data Viewer. Values of the form *_SD are 
standard deviations for that same time period. The time period is 
selected by trigger thresholds based on the water vapor 
concentration. The analyzer is characterized and specified based on 
the factory default trigger thresholds—changing these values is not 
recommended, please contact Picarro if you feel this is necessary.  

5. Lower Portion Of The Window (labeled Log): This window 
displays the action that is currently taking place. For those actions 
that take some time to complete, a period is displayed each second 
and a new line is started every thirty seconds to show progress. 

6. Coordinator Output Filename: Can be seen in the upper left of the 
Coordinator window. It follows an automated convention of: 

model, serial number, mode, year, month, date, and time. For 
example: 

HBDS34_HT_IsoWater_20190818_114019.csv 

This means the coordinator file output was taken using analyzer 
HBDS34 in high throughput isotopic water analysis starting on 18 
August 2019 at 11:40:19 am. 

How to Make the Sample Description File:  

The sample description file should be in CSV (comma separated value) 
format. Use the supplied NotePad++ software. Write the sample 
descriptions in the format as shown below.  

Tray,Vial,Identifier 1,Identifier 2 

1,1,Picarro 00,standard 

1,2,Picarro 11, standard 

1,3,Picarro 22, standard 

1,4,WA 1,first sample from Washington 

1,5,WA 2,second sample from Washington 

1,6,CA 1, first sample from California 

1,7,CA 2, second sample from California 

1,8,Picarro 00, standard 
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Figure 37: 
Sample 

Description 
Example 

 

After the first line (which should contain the column heading), each line 
should represent a sample description for the analysis results from a single 
injection. The lines in the file may be arranged in any order. The 
capitalization and spacing of the first line must exactly match the provided 
example. MS Excel can be used if the file is saved in CSV format. It is 
recommended to generate the file using Windows operating systems (as 
on the analyzer) as there are differences in CSV format between different 
operating systems. It is permissible to load the sample description files at 
any time during the data collection. The output file is rewritten to use the 
new sample descriptions, so that the most recently loaded descriptions are 
always used.  

11.5 Parameters Recommended for Standard, Express, and 
Survey Modes 

The widely accepted standard protocol for water isotope analysis is to run 
6 injections of the sample, and average only the last 3 data points to obtain 
the isotopic values of the sample.  

Using the Express mode, Picarro recommends running 10 injections per 
sample, and in similarity to the standard mode, average only the last 3 data 
points to obtain the isotopic values of the sample stage.  

Before launching the Express coordinator, please set number of injections 
to 10, and volume of sample to 1.8 µl, in the Autosampler user interface. 

Using the Survey mode requires only one injection. 

Before launching the Survey coordinator, please set number of injections to 
1, and volume of sample to 2.5 µl, in the Autosampler user interface. 
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The following table summarizes Picarro’s recommendations for processing 
samples. 

Coordinator Number of 
Injections* 

Sample 
Volume* (µl) 

Number of Injections 
to Discard** 

Standard 6 1.8 3 
Express 10 1.8 7 
Survey 1 2.5 0 

*Edits are done to the autosampler software method tab. 

**Edits are done to the ChemCorrect post processing parameters. 

When using samples with large isotopic range, more injections can be 
added to help reduce the memory effect. 

11.6 Coordinator Modes Available On a Picarro Water 
Isotope Analyzer  

The CRDS analyzer needs to be equipped with the appropriate hardware 
to support a coordinator mode.  

Hardware Associated Coordinator(s) 

High Precision Vaporizer (A0211) 

CRDS Analyzer (L21x0-i) 
Manual Injection 

High Precision Vaporizer (A0211) 

Autosampler (A0325) 

CRDS Analyzer (L21x0-i) 

L2130-i: 

 High Precision** 
 High Throughput**  
 Standard* 
 Express* 
 Survey* 

L2140-i 

 High Precision 
 High Throughput  
 High Precision 17O 
 Express* 
 Survey* 

*Only available with Coordinator 
software upgrade 
** only available without coordinator 
upgrade  

High Precision Vaporizer (A0211) 

Autosampler (A0325) 

Dual Mode 

Dual Mode 17O (if L2140-i) 



 
 

 

L21x0-i Inst/Op Manual P/N 40035 Rev. F 83 

Hardware Associated Coordinator(s) 

CRDS Analyzer (L21x0-i) 

Vaporizer Switching Valve (A0912) 

High Precision Vaporizer (A0211) 

Standards Delivery Module (A0101) 

CRDS Analzyer (L21x0-i) 

Standards Delivery Module (SDM) 

High Precision Vaporizer (A0211) 

Micro Combustion Module (A0214) 

Autosampler (A0325) 

CRDS Analyzer (L21x0-i) 

MCM High Precision 

MCM High Throughput 

MCM Manual Mode 

Induction Module (A0213) 

CRDS Analyzer (L21x0-i) 

Induction Module 

Continuous Water Sampler 

CRDS Analyzer (L2130-i or L2140-i) 

Continuous Water Sampler 

Description of Different Coordinator Modes: 

1. High Precision: Used to measure liquid water samples with 
maximum precision. Automatically injects and measures liquid 
samples. Each injection cycle takes 9 minutes. High Precision and 
High Throughput Coordinator Modes operate in the exact same 
fashion except that the steps of sample preparation and analysis are 
faster in the high throughput coordinator. 

2. High Throughput: Used for faster measurement of liquid water 
samples with good precision. Automatically injects and measures 
liquid samples. Each injection cycle takes 4 minutes. High Precision 
and High Throughput Coordinator Modes operate in the exact same 
fashion except that the steps of sample preparation and analysis are 
faster in the high throughput coordinator. 

3. Standard*: Used to measure liquid water samples with maximum 
precision. Automatically injects and measures liquid samples. Each 
injection cycle takes 9 minutes. 

4. Express*: Used for faster measurement of liquid water samples 
while retaining high precision. Automatically injects and measures 
liquid samples. Here we recommend 10 injection the first 6 
injections take 1.5 minutes while the last 4 injections take 5 minutes. 
The first 7 injections will be discarded to achieve the optimal 
memory reduction.  

5. Survey*: Used for super-fast measurements of large sample 
batches at moderate precision and enables an efficient sample 
sorting. By rearranging samples accordingly, we can reduce the 
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memory effect between adjacent sample. Automatically injects and 
measures liquid samples. Each injection cycle takes 95 seconds. 
For best practice, we recommend 1 injection per sample followed by 
manual sorting of samples according to survey results. 

*Only available with Coordinator software upgrade. 

6. Manual Inject: Used for semi-automated measurement of liquid 
water samples with maximum precision. Requires A0211 High 
Precision Vaporizer and A0322 Syringe Guide. User manually 
injects samples after prompt. The vaporizer control and the analysis 
of liquid samples are automated. Each injection cycle takes 9 
minutes.  

7. Dual Liquid/Vapor: Used for measurement of ambient vapor 
coupled with automated injection of liquid calibration standards. 
Requires A0211 high precision vaporizer, A0912 Dual Mode 
Configuration hardware and software for vapor calibration and 
Autosampler. Alternates between analyzing ambient vapor and 
liquid standards based on user defined sequence. Uses high 
precision method for liquid calibration. Each injection cycle takes 9 
minutes. 

8. Standards Delivery Module (SDM): Used for measurement of 
ambient vapor coupled with automated injection of liquid calibration 
standards. Requires A0211 High Precision Vaporizer and A0101 
standards delivery module. Alternates between analyzing ambient 
vapor from multiple points and a continuous stream of vaporized 
standard. The alternation is based on user defined sequence. A 
calibration measurement takes approximately 20 minutes per 
concentration/standard. Before operating in SDM mode, set the 
vaporizer temperature to 140°C.  

9. IM CRDS (Induction Module): Requires the IM. Used for isotopic 
analysis of extracted water from samples such as soil, plants, or 
tissues and allows the isotopic analysis of the extracted water. This 
requires the Induction Module.  

10. Micro Combustion Module (MCM): Used to measure liquid water 
samples while destructively removing potential contaminants with 
maximum precision. Requires A0211 High Precision Vaporizer, 
A0214 Micro Combustion Module and Autosampler. Automatically 
injects and measures liquid samples. Each injection cycle takes 9 
minutes. In addition to controlling the valve sequence for injection 
liquid water samples, the MCM coordinator also control the heating 
of the MCM to ensure removal of interfering organics.  

11. Continuous Water Sampler (CWS): Used for continuous, real-time 
measurements of water. Requires A0217 Continuous Water 
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Sampler. No discrete sampling is required. Automatically switches 
between calibration standards and samples using four inlet ports.  

 

IMPORTANT NOTE: The L2140-i can operate in four instrument modes 
(iH2O N2, iH2O Air, iH2O N2 O-17 and iH2O air O-17). Due to the high 
precision demands of 17O-excesss science, only the ‘High Precision’, 
‘Dual Mode’ and ‘Manual Inject’ coordinator modes will work for the two 
O-17 instrument modes. 

Description of Column Headers Used in Coordinators:  

The following table provides information regarding the column headers 
presented in the Coordinator output files available on a Picarro water 
isotope analyzer. The table includes the header for the following 
coordinators: 

 High Precision  

 High Throughput  

 Standard 

 Express 

 Survey 

 Dual Mode 

The table covers all variations of the coordinators. Coordinators vary by 
analyzer product number, therefore not all columns will be visible on an 
individual analyzer.  

Item Description 

Line  Line counter. Each line represents a single injection or data point 
(for vapor measurements in the dual mode).  

Analysis Sequential number of the sample run over the history of the 
analyzer. 

Time Code Time the line was recorded in “Year/Month/Day 
Hours:Minutes:Seconds”. This time stamp is linked the local time of 
your computer’s clock.  

Port 
 

Reports the vial position on the tray where the autosampler is 
sampling from. 

Inj Nr Sequential injection number from the port (vial). 
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Item Description 

d(17_16)Mean  The average  δ17O value, in per mil (‰), measured at that interval 
(Line). The typical raw data acquisition rate on a L2140-i is ~ 1 Hz, 
therefore this represents the average of 1 Hz data points across the 
water pulse. The averaging window is shown in red on the CRDS 
Data Viewer. The reported delta values are not calibrated. Post-
processing is required for calibration. Only available on a L2140-i. 

d(18_16)Mean  The average  δ18O value, in per mil (‰), measured for that injection 
(Line). The typical raw data acquisition rate on a L21x0-i is ~ 1 Hz, 
therefore this represents the average of 1 Hz data points across the 
water pulse. The averaging window is shown in red on the CRDS 
Data Viewer. The reported delta values are not calibrated. Post-
processing is required for calibration.  

d(D_H)Mean  The average  δ2H value, in per mil (‰), measured for that injection 
(Line). The typical raw data acquisition rate on a L21x0-i is ~ 1 Hz, 
therefore this represents the average of 1 Hz data points across the 
water pulse. The averaging window is shown in red on the CRDS 
Data Viewer. The reported delta values are not calibrated. Post-
processing is required for calibration. 

E17_Mean The average 17O-excess value, in per mil (‰), measured for that 
injection (Line). 17O-excess is the deviation the expected 
relationship between 17O/16O and 18O/16O ratios and is defined by:  
E17_Mean =  
ln[d(17_16)Mean + 1] – 0.528ln[d(18_16)Mean + 1] 
The typical raw data acquisition rate on a L2140-i is ~ 1 Hz, 
therefore this represents the average of 1 Hz data points across the 
water pulse. The averaging window is shown in red on the CRDS 
Data Viewer. The reported delta values are not calibrated. Post-
processing is required for calibration. Only available on a L2140-i. 

H2O_Mean The average water concentration, in ppm, measured for that 
injection (Line). The typical raw data acquisition rate on a L21x0-i is 
~ 1 Hz, therefore this represents the average of 1 Hz data points 
across the water pulse. The averaging window is shown in red on 
the CRDS Data Viewer. The reported delta values are not 
calibrated. 

Ignore -1 or 0: -1 indicates the measurement should be ignored and is 
based on the first three injections from each sample vial being 
ignored due to sample-to-sample isotopic memory.  

Good 0 or 1: 1 indicates that the mean H2O concentration is within the 
required range. 0 indicates that the mean H2O concentration is 
outside the required range.  
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Item Description 

Vapor d(17_16) Only reported when operating in the Dual Mode. Populated when 
the Dual Mode is measuring ambient vapor. Raw  δ17O output from 
the Analyzer with no averaging. The typical raw data acquisition rate 
on a L2140-i is ~ 1 Hz, therefore during the vapor measurement 
phase a line will be created every ~ 1 second. Only available on a 
L2140-i. 

Vapor d(18_16)  Only reported when operating in the Dual Mode. Populated when 
the Dual Mode is measuring ambient vapor. Raw  δ18O output from 
the Analyzer with no averaging. The typical raw data acquisition rate 
on a L21x0-i is ~ 1 Hz, therefore during the vapor measurement 
phase a line will be created every ~ 1 second. 

Vapor d(D_H)  Only reported when operating in the Dual Mode. Populated when 
the Dual Mode is measuring ambient vapor. Raw  δ2H output from 
the Analyzer with no averaging. The typical raw data acquisition rate 
on a L21x0-i is ~ 1 Hz, therefore during the vapor measurement 
phase a line will be created every ~ 1 second. 

Vapor E17 Only reported when operating in the Dual Mode. Populated when 
the Dual Mode is measurement ambient vapor. Raw 17O-excess 
output from the Analyzer with no averaging. The typical raw data 
acquisition rate on a L21x0-i is ~ 1 Hz, therefore during the vapor 
measurement phase a line will be created every ~ 1 second. Only 
available on a L2140-i. 

Vapor H2O Only reported when operating in the Dual Mode. Populated when 
the Dual Mode is measurement ambient vapor. Raw H2O 
concentration output from the Analyzer with no averaging. The 
typical raw data acquisition rate on a L21x0-i is ~ 1 Hz, therefore 
during the vapor measurement phase a line will be created every ~ 
1 second.  

Identifier 1 First identifier of the sample. Only populated if a sample description 
file is loaded when the coordinator is open. 

Identifier 2 Second identifier of the sample. Only populated if a sample 
description file is loaded when the coordinator is open. 

Gas Configuration Indicates the type of gas being measured. Water isotope analyzers 
measure water vapor sample. 

Timestamp Mean Unix timestamp. 

d(17_16)_SD Standard deviation of the measured  δ17O across an injection’s 
averaging window. The averaging window is show in red on the 
CRDS Data Viewer. Only available on a L2140-i. 

d(18_16)_SD Standard deviation of the measured  δ18O across an injection’s 
averaging window. The averaging window is show in red on the 
CRDS Data Viewer.  
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Item Description 

d(D_H)_SD Standard deviation of the measured  δ2H across an injection’s 
averaging window. The averaging window is show in red on the 
CRDS Data Viewer. 

H2O_SD Standard deviation of the measured H2O concentration across an 
injection’s averaging window. The averaging window is show in red 
on the CRDS Data Viewer. 

E17_SD Standard deviation of the measured 17O-excess across an 
injection’s averaging window. The averaging window is show in red 
on the CRDS Data Viewer. Only available on a L2140-i. 

d(18_16)_Sl Slope of the measured  δ18O across an injection’s averaging 
window. The averaging window is show in red on the CRDS Data 
Viewer.  

d(D_H)_SI Slope of the measured  δ2H across an injection’s averaging window. 
The averaging window is show in red on the CRDS Data Viewer. 

H2O_SI Slope of the measured H2O concentration across an injection’s 
averaging window. The averaging window is show in red on the 
CRDS Data Viewer. 

baseline_shift The average value for baseline shift, in ppb/cm, measured for that 
injection (Line). Baseline_shift is a spectral term that is measured on 
the L2130-i and L2140-i. It is the change in the constant term of the 
fitted baseline, relative to an empty cavity baseline which is 
measured at the Picarro factory. This column can be used to track 
potential spectral interference and data integrity. See ChemCorrect 
section.  

slope_shift The average value for slope shift, in ppb/cm, measured for that 
injection (Line). Slope_shift is a spectral term that is measured on 
the L2130-i and L2140-i. It is the change in the linear term of the 
fitted baseline, relative to an empty cavity baseline which is 
measured at the Picarro factory. This column can be used to track 
potential spectral interference and data integrity. See ChemCorrect 
section. 

residuals The average value for residuals, in ppb/cm, measured for that 
injection (Line). Residuals is a spectral term that is measured on 
the L2130-i and L2140-i. This term represents the root mean 
squared residual of the least-squares fit of the measured 
spectra versus the expected spectra. This column can be used 
to track potential spectral interference and data integrity. See 
ChemCorrect section.  
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Item Description 

baseline_curvature The average value for baseline curvature, in ppm*cm, measured for 
that injection (Line). Baseline_curvature is a spectral term that is 
measured on the L2130-i and L2140-i. This term represents the 
quadratic term in the fitted baseline. This column can be used to 
track potential spectral interference and data integrity. See 
ChemCorrect section. 

interval Average of the elapsed time between each fitted spectrum for an 
injection’s averaging window. 

ch4_ppm The average methane concentration, in ppm, measured for that 
injection (Line). This column can be used to track potential spectral 
interference and data integrity. Methane concentration is not 
calibrated and should not be used directly to determine the methane 
concentration in the water source. 

h16od_adjust This term represents an adjustment applied to WLMh16od_offset, a 
filtered and scaled frequency error derived from least-squares fit. 
h16od_adjust is only reported on the L2130-i and L2140-i. This 
column may be used to the Picarro Technical Support team in 
diagnosing wavelength locking. 

h16od_shift This term represents an adjustment applied to WLMh16od_offset, a 
frequency error derived from least-squares fit. h16od_shift is only 
reported on the L2130-i and L2140-i. This column may be used to the 
Picarro Technical Support team in diagnosing wavelength locking. 

n2_flag Flag for reported the measurement mode at the time of measurement. 
n2_flag will equal 1 for operation in the N2 mode, and equal to 0 for 
operation in the Zero Air mode. 

DAS Temp Temperature measured at the DAS board in the Picarro Analyzer. 

Tray Tray number. Relevant for CTC Autosampler (Picarro Part Number 
A0321).  

Sample Vial sample number. 

Job Line in the autosampler job queue. 

Method Autosampler method that is associated with the autosampler 
sequence.  

Error Code Error code associated with Autosampler operation. 
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11.7 Data Files 

During operation, the analyzer generates ASCII format text output file that 
is updated after each batch of concentration measurement is complete. 
The analyzer also creates directories to store the data based on the date 
the data was acquired. After each data file has been closed, it is moved to 
an archive directory, and a new file is started in the original location. To 
keep the data files easy to manage and to limit the size of individual files 
and directories, please see Setup Tools in the Utilities folder on your 
desktop to modify various aspects of data storage.  

There are two data directories: UserData and Archived Data. 

UserData 

This directory contains current and recent data. 

 DataLog_User: stores data as measurements are made. 

 Location: C:\UserData\DataLog_User\Year\Month\Day 

 Naming Convention: 

 Example: CFHADS2007-20111222-000131-DataLog_User.dat 

 CFHADS2007: Instrument Serial Number 

 20111222: Year, month, and day of when file was started  

 000131: Hour, minute, and second of when file was started (using 
a 24 hour clock and the local computer’s time).  

Archived Data 

This directory contains past data. 

 DataLog_User_Backup: archived, older data that is stored in 
compressed .zip format. 

o Location: 
C:\Picarro\G2000\Log\Archive\DataLog_User_Backup\Year\
Month\Day 

o Naming Convention: 

 Example: 
DataLog_User_Backup_20111107_005427.zip 

 20111107: Year, month, and day of when the file was 
started.  
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 005427: Hour, minute, and second of when file was 
started (using a 24 hour clock). 

 DataLog_Private: complete data file which includes additional 
parameters beyond the concentration data such as instrument 
temperatures and pressure, set points, and spectroscopic 
information. This information is generally not useful to the 
user, but it can be useful for diagnostic purposes. For more 
information, please contact Picarro. 

o Location: 
C:\Picarro\G2000\Log\Archive\DataLog_Private\Year\Month\
Day 
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Measuring Time in Picarro Data Files 

Since measurements performed by Picarro analyzers are asynchronous 
(they require a variable and unpredictable amount of time to complete) 
data reported by the analyzer is time stamped. Each independent 
measurement is given a time derived from the Windows™ computer’s 
system clock1. This time can be reported by one or many of the following 
variables. 

Variable Name Description Units 

DATE The calendar date formatted as YYYY-
MM-DD 

Example: August 24, 2015 is formatted 
as 2015-08-24 

-NA- 

TIME The time of day formatted as 
HH:MM:SS.SS on a 24-hour clock 

Example: 4:18:53.12 PM is formatted 
as 16:18:53.12 

-NA- 

FRAC_DAYS_SINCE_JAN1 The number of days since midnight 
January 1 of the current year  

Example: at 3:00:00 PM on January 12 
the value is 11.625 

days 

FRAC_HRS_SINCE_JAN1 The number of hours since midnight 
January 1 of the current year  

Example: at 3:00:00 PM on January 12 
the value is 279.0 
(=FRAC_DAYS_SINCE_JAN1*24) 

hours 

JULIAN_DAYS The number of the day of the current year  
Example: at 3:00:00 PM on January 12 
the value is 12.625 
(=FRAC_DAYS_SINCE_JAN1+1) 

days 

EPOCH_TIME The number of milliseconds since 
midnight January 1, 1970 

Example: at 3:00:00 PM on January 12 
the value is 1421074800000 (= time) 

ms 

timestamp The number of milliseconds since 
midnight January 1, 1 if the current 
Gregorian calendar was extended back to 
that time 

ms 

 

 

 

 

1 http://en.wikipedia.org/wiki/System_time  
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Variable Name Description Units 

Example: at 3:00:00 PM on January 12 
the value is 63556671600000 

time The number of milliseconds since 
midnight January 1, 1970 

Example: at 3:00:00 PM on January 12 
the value is 1421074800000 (= 
EPOCH_TIME) 

ms 

ymd The calendar date formatted as 
YYYYMMDD 

Example: August 24, 2015 is formatted 
as  
20150824 

-NA- 

 

In the table above, all times are reported in GMT2 (also known as Zulu time 
and very closely related to UTC). We express these timestamps in GMT to 
avoid complications during Daylight Saving Time or when instruments are 
moved across time zones. The accuracy of the times are, of course, only 
as good as the accuracy of the Windows™ clock, see section REMOTE 
DATA ACCESS to learn how to automatically synchronize the computer’s 
clock to a time standard. There are many online calculators3 that convert 
Epoch Time to local time at any time zone, as well as many functions in 
commonly used data analysis p  

 

  

 

 

 

 

2 http://en.wikipedia.org/wiki/Greenwich_Mean_Time  

3 For example, http://www.epochconverter.com  
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11.8 ChemCorrect Software 

Principle of Operation 

Picarro CRDS has become a de facto standard for many water sample 
research areas, such as ice core, watershed, and aquifer studies. For 
various reasons, samples can contain a variety of chemical contaminants, 
which in some cases can lead to spectral interference that can degrade the 
accuracy of results. It is difficult to eliminate these contaminants from water 
samples without fractionating the isotope ratios and diminishing sample 
fidelity.  

Proprietary software, called ChemCorrect™, comes pre-loaded on your 
Picarro water isotope analyzer. This program solves the problem of data 
degradation and fidelity resulting from water samples contaminated with 
trace hydrocarbons. In addition, ChemCorrect™ can be used to correct 
data an isotope reference scale (typically VSMOW-SLAP for water 
isotopes). The software makes the a priori assumption that your standards 
are clean waters that do not contain any contamination. Then the program 
compares a number of features in the spectra from the samples and the 
standards, applies a statistical test to see if the samples are different from 
the standards, and assigns flags based the statistical differences. These 
flags alert you to artifacts, potentially from contamination, that may affect 
the accuracy of your results. Finally, the software using a linear regression 
to correct your samples to an isotope reference scale by comparing the 
measured values of your standards to their accepted values.  

How Contaminants Impact The Optical Spectrum 

Contaminants fall into one of the following three categories, based on the 
nature of the distortion to the optical spectrum:  

1. Compounds that do not affect the spectrum (at concentrations up to 
10-20% of the water sample). Most compounds fall into this 
category. In the presence of these contaminants, Picarro analyzers 
will report accurate and precise isotope values without bias or 
increase in noise.  

2. Large compounds (with more than about 6-8 atoms) contribute a 
broad, spectrally unresolved absorption baseline beneath the target 
molecules. To first order, this baseline will cause no systematic bias 
to the reported values. Because optical absorption is a linear, 
additive process, the water vapor spectrum will ‘float’ on top of the 
contaminant baseline. The linearity and wide dynamic range of 
CRDS makes the technique particularly insensitive to these baseline 
offsets.  
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In some cases, however, this baseline offset is accompanied by a 
tilt of the spectrum with wavelength. This larger offset, if 
uncorrected, can cause bias in the measurements and degrade the 
precision of the instrument.  

3. Small compounds (with fewer than 6-8 atoms) have spectrally 
resolved absorption lines that can interfere with the lines from the 
observed water vapor. This can lead to systematic errors in the 
reported isotope ratios. One example of such a molecule is 
methanol, which has a particularly complex absorption spectrum in 
this spectral region.  

The ChemCorrect™ software uses known spectral interferences or 
general spectral patterns to identify trends due to contamination. 

 

ChemCorrect™ on the L2130-i and L2140-i:  

The L2130-i and L2140-i, when operating in ‘normal’ measurement mode 
(δ18O and δD), also measure spectral indicators that can be used to 
determine the integrity of the spectra and resulting data.  

Using the spectral indicators listed below, the ChemCorrect™ software 
performs statistical tests to determine how those spectral features differ 
between the samples and the standards.  

 RESIDUAL: the root mean squared residual of the least-
squares fit to a spectra, in units of ppb/cm, is used to screen 
for potential small molecule contaminants, e.g., methanol.  

 BASELINE SHIFT: the spectral baseline is a good early 
indicator of a potential issue with a sample. The baseline shift 
term is a change in the constant term of a fitted baseline, in 
units of ppb/cm.  

 BASELINE CURVATURE: the spectral baseline is a good early 
indicator of a potential issue with a sample. The baseline 
curvature team is a change in the quadratic term of a fitted 
baseline, in units of ppb*cm. 

 SLOPE SHIFT: the slope of the spectral baseline or change in 
the linear term of the fitted baseline, in units of ppb/cm, 
although not unique is also a useful indicator for moderately-
sized molecules, e.g., ethanol that can interfere with nearby 
spectral features.  
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The software flags these indicators if they deviate from the thresholds set 
in ChemCorrect. 

For example, a red flag can be triggered by any of the following:  

 the sample residual being 1.5  away from the mean of the 
standards residual 

 the sample baseline shift being 18  away from the mean of the 
standards baseline shift 

 the sample baseline curvature being 3  away from the mean of 
the standards baseline curvature  

Sometimes the software generates false positives by flagging features that 
do not arise from contamination. To reduce the number of false positives, 
the notification thresholds can be changed to be less stringent. This can be 
done by editing the ChemCorrect™ Instruction Set. If a user edits the 
Instruction Sets, we recommend changing the name of the Instruction Set 
so that it is possible to revert to the original set supplied by Picarro.  

If a flag is raised, a number of things can be done. First, try some offline 
sample treatment methods, such as the use of activated charcoal. Second, 
if you suspect alcohols may be present in your samples, you can utilize 
Picarro's Micro Combustion Module (MCM) to remove those artifacts. 
Third, and as a last resort, you can analyze your samples using an 
alternative technique, such as Isotope Ratio Mass Spectrometry (IRMS). 
IRMS is not susceptible to spectral interference from alcohols; it can, 
however, introduce other analytical artifacts and have other interferences, 
such as mass interference, that can affect accuracy.  

Analysis of Coordinator Files 

The following Coordinator output files can be post-processed using 
ChemCorrect™: 

 High Precision 

 High Throughput 

 Manual Injection 

 Standard 

 Express 

 Micro Combustion Module 
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ChemCorrect™ cannot be applied to data δ17O and 17O-excess data. Nor 
can it be applied to Coordinators generated during SDM, IM, Dual Mode or 
Continuous Water Sampler Setups.  

Preparing the Run Sequence: 

1. Each run needs at least 2 standards (3 is recommended but more is 
better) with known  δ18O and  δD values. These values create a 
linear fit, which is used in calibration of the samples. 

2. The standards must be run one after another at the beginning of 
each tray to be analyzed. The post processing software works 
sequentially and therefore requires the linearity of the known 
standards before it can correct the unknown values of the samples. 
It is recommended to include standards in the middle and end of the 
sample set as controls. An example is shown below, vials with the 
CYAN stars being the standards: 

Figure 38: 
Run Sequence 
with Standards 

 

3. Due to memory, the first two to three injections of each vial should 
be ignored. Because of this, a minimum of six injections should be 
run per vial. The number of injections is set using the Autosampler 
Controller software (A0325) or the external control pad of the CTC 
Autosampler (A0321) prior to the run. 

Files Required to Run ChemCorrect™: 

ChemCorrect™ requires a standards file, an instruction set, and a source 
file (data output from the coordinator software that is in C:\IsotopeData). 
Each of these files are provided in .csv formats. To ensure the standards 

STANDARD 
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file format is preserved, Picarro recommends editing the file using 
Notepad++ which is provided with the analyzer.  

A sample data file along with the standards and instruction files can all be 
found in the ChemCorrect™ main folder C:\Picarro\ChemCorrectExe. 

Standards File: 

The standards.csv file must contain the name and known δ18O and δD 
values of each standard (relative to an isotope reference scale, typically 
VSMOW-SLAP for water isotopes). The names in the standards.csv file 
must match (case-sensitive) the names in the source file under 
“Identifier 1”. If they do not match, standards will be treated as samples.  

Figure 39: 
Standards 

CSV File 
Example 

 

Instruction Set:  

The instruction set is provided by Picarro. 

 L2130-i / L2140-i Instruction Set: chemcorrect_inst 
avg_orgeval_10.csv 

Source File:  

This is the output file from the Coordinator (stored in C:\IsotopeData). 
Before closing the Coordinator at the end of an Autosampler Sequence, it 
is advised to load the sample description file. Below is an example of a 
sample description file. Ensure that the “Identifier 1” for standards is 
identical to the “Standards Name” list in the standards file.  
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Figure 40: 
Sample 

Description 
File 

 

Running ChemCorrect™: 

1. Double-click the ChemCorrect™ icon on the analyzer desktop. The 
ChemCorrect™ program will now open. 

2. The top four boxes are the required fields: the most recent Source 
file name (sometimes empty), Instruction Set name, Standards File 
and the number of Injections to Ignore. You also have an option to 
plot additional graphs for other parameters.  

3. To choose a different source file to be analyzed, click the “Source” 
button located on the bottom of the window. Then use the finder 
window to locate the desired raw data file and click “Open.” 

4. To select a different instruction file than the one displayed, click the 
“Instruction Set” button located on the bottom of the window. Then 
use the finder window to locate the desired instruction file and click 
“Open”.  

5. To change the number of injections to be ignored, highlight the 
existing number and type in the preferred one (required 2 but 3 is 
recommended). Do not leave this field blank. 

6. When the correct source and instruction files are shown, click the 
“OK” button at the bottom of the window to start the ChemCorrect™ 
analysis. 
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Figure 41: 
ChemCorrect 

Window 

 

Example Analysis: 

See the figure below. 

1. Select “HBDS01_IsoWater_20100604_180843.csv” (which Picarro 
has provided in the main folder) as the source, and 
“chemcorrect_inst avg_orgeval_06.csv” as the instruction file. Then 
click “OK.” 

2. The first display is called the “Summary.” Contained here are: the 
calibrated isotope values and visual indicators as to the severity of 
contamination by sample. 

3. The CYAN rows are standards. 

4. The GREEN rows are samples that have been determined to have 
little to no contamination. 

5. The YELLOW rows are samples that contain trace values of 
contamination that may slightly shift the isotope values. 

6. The RED rows are samples with severe contamination leading to 
inaccurate  δ2H and  δ18O readings. 

Different Instruction 
Sets and Standards 
files are used for 
different analyzers. 

Make sure there is a 
number here. Do not 
leave blank. 
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7. A star next to a sample indicates a problem, e.g. missing rows in the 
source file resulting in an inaccurate calculation. 

8. Red/yellow rows display relative contamination due to methane, 
methanol, or “other” hydrocarbons in the respective columns on the 
right. 

Figure 42: 
ChemCorrect 

Analysis 

 

9. There are other tabs that can be accessed by clicking on them in 
the top left corner of the window. 

10. Detail: Summons a list of summarized charts by injection and 
sample chronologically. The un-calibrated and calibrated values, as 
well as the measurements taken to calibrate the values are included 
per injection. Below each chart is a summary. 

11. Source: Displays the original raw data file without any changes or 
calibration. 

12. Instructions: Displays the raw instruction file used by 
ChemCorrect™ as well as comments on the far right of each 
instruction. 

13. Additional plots for visualizing your data. 

14. At the bottom of the ChemCorrect™ window are additional buttons 
“OK”, “Export Spreadsheet,” and “Exit” buttons.  

15. OK: each time you reloaded the source and instruction sets, you 
can click “OK” again to process more data without closing and re-

CYAN- Standard 
 
GREEN- Clean 
 
YELLOW- Some 
Contamination 
 
RED- Substantial 
Contamination 
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opening ChemCorrect™. Once you make your edits, export the 
result to save your processed data.  

16. Export Spreadsheet: Creates an excel spreadsheet complete with 
all the information contained in the four tabs in the ChemCorrect™ 
main window as well as all the data sets and formulas used to 
calibrate the isotope values. 

17. Exit: Quits ChemCorrect™.  

18. The standards.csv file can be amended if needed, but the format 
must remain the same. To edit, simply open the file, make the 
desired changes, and hit save. For the changes to be reflected in 
ChemCorrect™, hit the “OK” button at the bottom of the 
ChemCorrect™. 

19. For more advanced users, Instruction Sets can be edited to perform 
your required calculations. If editing the Instruction Set, we 
recommend changing the name of the Instruction Set so that it is 
possible to revert to the original set supplied by Picarro.  

 

Picarro recommends running the post processing within 7 days of 
initially acquiring the data. If a sample is flagged as contaminated, 
the post processing software will automatically set aside the 
associated spectral files. These files can be sent to Picarro for 
further analysis and spectral library development. Once set aside, 
these files will not be affected by the automatic file management 
software which is running on the analyzer. 

Due to the large amount of data generated by the analyzer a buffer 
of approximately 10 GB of spectral files are kept, after which point, 
they are erased. This corresponds to approximately 2 weeks of 
operation. Running the post processing ensures that any spectra 
associated with contamination are not erased. 

11.9 Cavity Ring-Down Spectrometer Controller 

On your desktop, there is an icon labelled “Picarro Controller.” Clicking on 
this icon will open up a useful diagnostics panel (see image below), 
allowing the user to see the analyzer’s internal temperatures, pressure, 
and spectroscopy in real time. This program has user-accessible functions 
but cannot change anything related to analyzer functionality and is 
intended for diagnostics purposes only.  
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Figure 
43: 

CRDS 
Controller 
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12. PERFORMANCE VERIFICATION 

12.1 Drift and Precision Testing 

Precision and drift tests for  δ18O and  δ2H ( δD) are recommended every 6 
to 12 months throughout an analyzer’s lifetime. This will allow you to verify 
a new installation, track performance as the instrument ages, determine if it 
is time for a Factory Refresh, and perhaps identify a small problem before 
it becomes a major setback. These tests can also be performed when data 
quality suddenly and inexplicably deteriorates.  

Here are the testing procedures for each analyzer:  

L2130-i and L2140-i: 

The drift and precision test for a L2130-i and L2140-i is conducted by 
measuring water from the wash station, instead of vials. These analyzers 
are precise enough to detect small variability in the composition of water 
from individual vials, even if it was sourced from the same supply. By 
running the drift and precision test from the wash station, vial to vial noise 
is avoided.  

The following instructions are written for the Picarro Autosampler (part 
number A0325). If you are using a CTC-style Autosampler (part number 
A0321), please consult the following Community post for additional 
information: https://www.picarro.com/support/community/using-
autosampler-inkwell-wash-station-sample-precision-test-water-analyzer.  

1. Fill a wash station jar with water and screw on the cap. The water 
should be pure deionized water, with no organics or salts, although 
tap water, bottled water, or one of your secondary standards can 
also be used. Because of the large volume required, we do not 
recommend using primary standards for this test. The water should 
be pure deionized water, with no organics or salts. The sample 
should be filtered if it contains particulate matter.  

2. Load the wash station into the rear wash station (Wash Station 1) 
holder on the Autosampler.  

3. Double-click on the desktop icon ‘Autosampler Control.’ This will 
open the program that controls the Autosampler.  

4. In the top row of the sample list, check the box to the right of the 
button ‘Clear.’ Then use the keyboard command ‘Ctrl + i’ to switch to 
the wash station test mode. This is a run sequence that will only 
draw water out of wash station 1. Select the method ‘Picarro’ from 
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the drop down list and enter 150 into the box underneath the column 
‘#Inj.’. This will set up a run of 150 injections from the wash station.  

Figure 44: 
Autosampler 

Control 
Window 

 

5. Minimize the Autosampler window and double-click on the desktop 
icon ‘Coordinator Launcher.’ This will open the window ‘Picarro 
Coordinator Launcher’ with a dropdown menu ‘Select Coordinator.’ 
Select ‘High Precision’ and click ‘Launch.’ Once the ‘CRDS 
Coordinator’ window is open, it will start to run through a series of 
checks, which include cleaning the vaporizer by opening and closing 
valves.  

6. Return to the Autosampler window and click ‘Run.’  

7. Once the vaporizer cleaning has finished, the Coordinator will 
initiate the first injection from the Autosampler. Then it will run 
through the entire Autosampler queue that was set up in step 5. The 
complete Autosampler queue will include 150 injections and it will 
take approximately 24 hours. You can monitor the progress of the 
run in the ‘CRDS Coordinator’ window. Please check to ensure that 
H2O concentrations of the first few injections fall within about 17,000 
to 23,000 ppm, and that the injection concentrations are within 
about ± 1,000 ppm of each other. You can now leave the system to 
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run for 24 hours, during which time it will collect the necessary data 
to test the precision and drift of the instrument. 

8. When the run is complete, navigate to the file C:\IsotopeData and 
identify the Coordinator output file. The correct file name can be 
found in the CRDS Coordinator window in the ‘Filename’ box, and 
the file will have the format .csv (comma-separated values). Move 
this file to another computer with Microsoft Excel or similar 
spreadsheet program. 

9. Open the .csv Coordinator output file. Then copy and paste data 
from the columns labeled ‘d(18_16)Mean’ and ‘d(D_H)Mean’ into a 
drift and precision test analysis spreadsheet that can be 
downloaded here: 
https://picarro.box.com/s/20dfkjs0szvl6mftg8cg.The spreadsheet is 
set up to calculate precision and drift and record the values in table 
provided. Within the spreadsheet, you will find a table labeled 
‘Report.’ Review this table and check the cells underneath the 
column ‘State.’ If these cells read ‘pass,’ the instrument passed the 
standard drift and precision test. If any boxes are labeled ‘fail,’ you 
should contact Picarro’s Technical Support team at 
support@picarro.com. Please provide the serial number of your 
analyzer.   
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12.2 Leak-Free Operation with a High Precision Vaporizer 
(A0211) 

Following an injection of liquid into the water isotope analyzer, the shape of 
the square "pulse" in the water concentration versus time graph provides 
information about the quality of the injection and any potential problems 
that can lead to poor data.  

One potential problem is a leak between the vaporizer and the analyzer. 
These leaks can be detected by plotting the water concentration along with 
the “outlet proportional valve” setting during the analysis. The outlet valve 
performance provides a way to identify unexpected pressure changes in 
the system, and it is useful indicator of vaporizer performance. Here’s why: 
The vaporizer converts a liquid sample into gas. At the beginning of sample 
analysis, one of the vaporizer valves is opened to the analyzer to allow gas 
to pass from the vaporizer into the analyzer cavity. During analysis, the 
pressure in the cavity steadily decreases because the gas is leaving the 
fixed volume of the vaporizer. To keep the cavity pressure constant, the 
outlet proportional valve slowly adjusts to compensate for the pressure 
change at the inlet. 

For additional background on the operation of the High Precision 
Vaporizer, you can review the following Picarro Community post online: 
http://www.picarro.com/community/picarro_community/vaporizer_a0211_o
peration_schematic  

Viewing the Outlet Valve Position 

To access the outlet valve position plot within the CRDS Data Viewer GUI, 
go to Settings > Change GUI Mode. When asked for a password, use the 
default Picarro password (“picarro”), and press OK. Now you can select the 
Outlet Proportional Valve plot. 

The outlet valve position is also recorded in the Private Data Log files (see 
“Archived Data” section for details on how to access these files). If you 
would like the data stored in the User Data, you can use the Setup Tool to 
include the outlet valve in your user data files. 
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Typical Appearance of Water Concentration and Outlet 
Proportional Valve Graphs 

For all of the following plots, the water concentration is the top graph and 
outlet proportional valve position is on the bottom. Ideally, the water pulse 
should be square, and the outlet proportional valve position should 
gradually decrease at the flat top of the water pulse, as shown below. 
These features correspond to the outlet valve gradually closing during the 
analysis of the pulse.  

Figure 45: 
Ideal Water 

Concentration 
and Outlet 

Proportional 
Valve Graphs 

 

For a proper analysis, the concentration of the dry gas (between the 
pulses) should be < 500 ppm H2O. The peak height of the pulse should be 
reproducible (within ± 1,000 ppm) and between approximately 17,000 and 
23,000 ppm.  
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Water Concentration and Outlet Proportional Valve Graph 
Problems and Potential Causes 

Problem: Extra Pulses after the Main Sample Pulse 

The image below shows extra little "pulses" after the main sample pulse. 
Note that the peaks for the main pulses appear normal, and the outlet 
valve is operating normally. The problem is during the cleanout cycle of the 
vaporizer, not during sample delivery. 

There are three potential causes of this problem: 

1. Leaky vaporizer septum. This should be changed after every ~ 300-
400 injections. 

2. Bad vaporizer vacuum pump. The pump may be starting to fail if it 
has more than 10,000 hours of use. 

3. Bad connection between the vaporizer vacuum pump and the 
vaporizer. Check the tubing and swage connections for cracks near 
the metal connections. Be careful not to over-tighten the swage 
fittings. 

Figure 46: 
Extra 

Pulses after 
the Main 
Sample 

Pulse 
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When re-attaching 1/4” Swagelok fittings, the nut should be hand-
tightened and then turned an additional 1/8 of a turn using a 
wrench. 

Problem: Extra Peaks Before and After the Main Sample 
Pulse 

The water concentration graph below has two abnormalities: an extra little 
peak after the main peak, and a "spike" at the beginning of the main peak. 
Note also that the outlet proportional valve is flat. This indicates that the 
outlet valve is constant during the time the analyzer is drawing air from the 
vaporizer's internal fixed volume. Because the outlet valve is constant, the 
pressure on the inlet of the analyzer is not changing. This indicates there is 
a leak between the analyzer and the vaporizer.  

The spike at the beginning of the main pulse could be moist ambient air 
entering through the leak. In this particular example, the spike peaks at ~ 
12,000ppm. In a dry environment, a leak might look like a slope going 
upwards from left to right with a dependence on the ambient conditions 
relative to the nominal 20,000 ppm concentration of the vaporized sample. 
A very leaky septum could also look similar. 

Figure 47: 
Extra Peaks 
Before and 
After Main 

Sample Pulse 
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Problem: Decreasing Concentration in the Main Pulse 

In this example, the outlet valve is constant during the pulse, but the pulse 
has a decreasing concentration. This is consistent with a leak of lower-
concentration ambient air into the analyzer during analysis. This leak is 
likely at the connection from the vaporizer to the analyzer.  

Figure 48: 
Decreasing 

Concentration 
in Main Pulse 
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Problem: Water Pulse Is Sloped 

The slope of the main pulse in the water concentrations, particularly one 
going upwards as in the first example shown below, indicates poor mixing 
inside the vaporizer. This can happen if the valve that injects dry gas into 
the vaporizer is not working perfectly. In this case, the outlet valve position 
is basically normal and therefore a leak between the vaporizer and 
analyzer is excluded as the cause of the problem.  

In the second example below, however, note the change in the nominal 
outlet valve position. This shows the vaporizer is filling to different 
pressures with each pulse, so there is inconsistent filling of the vaporizer.  

If you see either: 

 Variation in the nominal stopping position of the outlet valve, 
or 

 Large increases in water concentration during a pulse 

Contact Technical Support (support@picarro.com) and we can help 
diagnose and repair the fault, if necessary. Please always provide your 
analyzer and vaporizer serial number when contacting Picarro.  

Figure 49: 
Water Pulse 

Sloped – Poor 
Mixing in 

Vaporizer 
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Figure 50: 
Water Pulse 

Sloped – 
Inconsistent 

Filling of 
Vaporizer 
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Problem: Variability in Measured Water Concentration 

The measured water concentration should consistently be near 20,000 
ppm (±1000 ppm). The circled areas in the water graph below shows 
values that are higher or lower than expected. The outlet valve behavior is 
normal.  

This can happen if the syringe is clogged, causing inconsistencies in the 
injected volume. Another possible problem is an inconsistent gas supply, 
perhaps due to a failing regulator or another piece of equipment using the 
same dry gas supply. This causes inconsistent pressure or flow at the inlet 
dry gas supply.  

Other problems associated with sample delivery are: 

 Overfilling or pressurizing the liquid in the vials 

 Significant contamination of the samples 

 Insufficient needle depth resulting in the collection of air, rather 
than liquid 

 Variable volume bubble in the syringe  

 

A test injection is recommended before each run, when you change a 
syringe, or if water concentrations during the pulse are consistently 
outside of the ideal ~ 17,000 to 23,000 ppm range. It is possible to scale 
the injection volume by the appropriate percentage to target the ideal 
water concentration range (see section Adjusting Injection Volume). 

 

Figure 51: 
Water Pulse 

Sloped – Water 
Concentration 

Variability 

 



 
 

 

L21x0-i Inst/Op Manual P/N 40035 Rev. F 115 

Problem: Water Concentration Suddenly Decreases 

In this example, the measured water concentration drops to near the 
baseline. This can happen if the needle penetration depth into the 
vaporizer changes and is not deep enough to get the sample into the 
vaporizer. The tall peak at left is a partial injection, but the subsequent 
peaks indicate that very little water was injected into the vaporizer. 

Figure 52: 
Water Pulse 

Sloped – 
Sudden 

Decrease in 
Water 

Concentration 
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Problem: Baseline of Water Concentration and Outlet Valve 
Change 

This is what happens when a normal analysis runs out of dry air from the 
dry air cylinder. The same behavior is also possible if there is a large gas 
leak in your cylinder. As the cylinder gas pressure goes to zero, the 
vaporizer is forced to take in moist room air, either from the leak or 
backwards through the Wavelength Monitor (WLM) purge line. The result is 
that the nominal dry baseline rises to the level of the room air. Also, the 
outlet valve position decreases since the vaporizer experiences less 
pressure from the cylinder gas. 

Figure 53: 
Baseline of 

Water 
Concentration 

and Outlet Valve 
Change 
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Problem: Water Pulses Split Into Multiple Peaks 

The final example shows what happens if the analyzer's solenoid valve 
sequencer is running at the same time the coordinator is. The solenoid 
valve sequencer should be disabled by default for Picarro water isotope 
analyzers. It the sequencer runs at the same time as the coordinator, the 
two components send conflicting signals to the valves that control the 
vaporizer. In this example, the sequencer is turned off following the third 
pulse, and the final pulse returns to normal. 

Figure 54: 
Water Pulses 

Split Into 
Multiple 

Peaks 
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13. CALIBRATION 
Calibrating your Picarro water isotope analyzer involves three steps: 

 Measuring the isotopic composition of known standards 

 Determining the relationship between the measured value and the known 
value 

 Adjusting the settings on the analyzer to account for any difference between 
the measured and known values, so that the on-screen readings are 
accurate.  

Picarro recommends calibrating your Picarro L21x0-i analyzer using liquid water 
samples. All water isotope standards should have accepted values for δ18O and 
δ2H. If applicable, the standards should also be calibrated for 17O-excess. Picarro 
recommends referencing all isotope data back to the internationally-recognized 
VSMOW-SLAP scale.  

 

Upon manufacturing, Picarro guarantees the performance of your 
analyzer with respect to precision. The system is also calibrated 
using isotope standards, however Picarro does not certify the 
analyzer for accuracy. It is the responsibility of the instrument user 
to verify the factory-calibration and to calibrate the instrument for 
accuracy. 

13.1 Primary and Secondary Standards 

The isotopic composition of a water sample is typically determined relative 
to the known value in a standard using delta notation:  

𝛿 𝑂ଵ଼ ൌ ቆ
ሺ 𝑂/ 𝑂ሻଵ଺ଵ଼

௦௔௠௣௟௘

ሺ 𝑂/ 𝑂ሻଵ଺ଵ଼
௦௧௔௡ௗ௔௥ௗ

െ 1ቇ ∗ 1000  

𝛿 𝐻ଶ ൌ ቆ
ሺ 𝐻/ 𝐻ଵଶ ሻ௦௔௠௣௟௘

ሺ 𝐻/ 𝐻ଵଶ ሻ௦௧௔௡ௗ௔௥ௗ
െ 1ቇ ∗ 1000  

𝛿 𝑂ଵ଻ ൌ ቆ
ሺ 𝑂/ 𝑂ሻଵ଺ଵ଻

௦௔௠௣௟௘

ሺ 𝑂/ 𝑂ሻଵ଺ଵ଻
௦௧௔௡ௗ௔௥ௗ

െ 1ቇ ∗ 1000 

These delta values can be used to construct secondary parameters: 

Deuterium-excess (d-excess): d-excess = δD – (8 * δ18O) 

17O-excess: 17O-excess = ln(δ17O+1) – (0.528 * ln(δ18O+1)) 
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There are three international “primary” standards:  

 VSMOW2 – Vienna Standard Mean Ocean Water 2 

 SLAP2 – Standard Light Antarctic Precipitation 2 

 GISP – Greenland Ice Sheet Precipitation 

The table below shows the isotopic compositions of each standard: 
 

 δ18O (‰)  δ2H (‰) 17O-excess (‰)  δ17O (‰) 

VSMOW2 0 ± 0.02 0 ± 0.3 0 0 

SLAP2 -55.50 ± 0.02 -427.5 ± 0.3 0 -29.6968 

GISP -24.76 ± 0.09 -189.5 ± 1.2 0.022 ± 0.011 -13.16 ± 0.05 

 

The  δ18O and  δ2H values are defined based on publications by the 
International Atomic Energy Agency (IAEA): 

VSMOW2: 
https://nucleus.iaea.org/sites/ReferenceMaterials/Pages/VSMOW2.aspx 

SLAP2: 
https://nucleus.iaea.org/sites/ReferenceMaterials/Pages/SLAP2.aspx 

GISP: 
http://nucleus.iaea.org/rpst/ReferenceProducts/ReferenceMaterials/Stable_
Isotopes/2H18O-water-samples/GISP.htm  

By definition, 17O-excess and  δ17O for VSMOW2 is 0. Recommendations 
have also been made in the literature for the values of 17O-excess for 
SLAP2 and GISP (Schoenemann et al., 2013). Using those 
recommendations,  δ17O of SLAP2 and GISP is calculated.  

Schoenemann, S.W., Schauer, A.J., and Steig, E.J. (2013) “Measurement 
of SLAP2 and GISP  δ17O and proposed VSMOW-SLAP normalization for  
δ17O and 17O-excess”, Rapid Communications in Mass Spectrometry, doi: 
10.1002/rcm.6486 
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Since these standards are expensive and sample limited, each lab should 
develop their own secondary, or working, standards. Example sources for 
secondary standards include: 

 Local precipitation (variable isotopic composition) 

 Local tap water (variable, related to local precipitation) 

 Kona Deep, Destiny Deep Sea Water (~ 0 ‰) 

 Snow or ice from your favorite alpine region (depleted) 

 Tap water from your colleagues across the globe (variable) 

The isotopic composition of a secondary standard should first be measured 
against a primary standard. Once calibrated with respect to the VSMOW-
SLAP isotope scale, it can be used for routine, daily calibration. About 
1.2 L of a secondary standard would be enough for a year’s supply. This 
assumes each standard is measured 2x per day using a standard 2 mL 
autosampler vial, and that the analyzer is operated 300 days per year 
(2 mL / vial x 2 standard vials / day x 300 days = 1.2 L).  

13.2 Tools, Equipment and Samples Required 

1. Waters with known isotope signatures, i.e., a verified δ18O, δ2H and 
17O-excess (if applicable) value.  

 Picarro recommends all labs purchase one supply of 
primary isotope standards from IAEA or USGS. These 
primary standards should not be used on a daily basis. 
Instead, they can be used to calibrate secondary or in-
house standards.  

 Secondary or in-house standards that bracket the isotope 
space of your sample set. A set of three working water 
isotope standards is also available from Picarro (part 
number C0350). These standards have been calibrated for 
δ18O and δ2H against the VSMOW-SLAP scale. 

2. 2 mL sample vials with caps. Picarro sells water isotope kits for 500 
or 1,000 samples (part number C0328 and C0329, respectively). 
These kits include 10 µL syringes, 2 mL glass vials with caps and 
injection port septa. Quantities vary based on the kit selected; visit 
the Picarro Store for more information: 
https://picarroinc.force.com/picarrosupport   
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3. Pipette for transferring water from primary storage (e.g., pressurized 
stainless steel barrels) to secondary storage (e.g., sealed amber 
vials) and eventually into sample vials (2 mL sample vials with caps 
and septa). 

4. Permanent marker or label maker for labeling sample vials.  

5. Refrigerator (or freezer) for storing water standards. If storing waters 
in the freezer, ensure the water is either stored in an expandable 
container or that the container has ample room for water expansion 
upon freezing. Also ensure the water is completely defrosted before 
conducting any analysis or sub-sampling from the water. For 
additional information on storing water isotope standards, please 
see section Sample and Standard Handling.  

13.3 Calibration methodology 

You should calibrate your samples using water standards that are 
introduced to the analyzer using an identical (or as close to identical) 
methodology as the samples. 

  For clean liquid water samples, analyze your standards using 
the same method, i.e., with the High Precision Vaporizer and 
Autosampler. 

 When using the Micro Combustion Module (MCM) to analyze 
plant waters and other contaminated waters, also analyze your 
standards using the MCM.  

 For ambient atmospheric monitoring, calibrate your system 
using liquid water standards of known isotopic composition 
using a Standards Delivery Module or dual mode kit. You can 
also design your own lab-built nebulizer or bubbler. For 
ambient atmospheric studies, calibrate for both accuracy in 
delta space and the dependence of delta value on water vapor 
concentration.  

 For matrix bound water analyzed using the Induction Module 
(IM), measure your liquid water standards using the sample 
introduction methodology and heating recipe.  

 For the Continuous Water Sampler, produce large volumes of 
tertiary water standards that can be analyzed on the CWS. 
Calibrate these standards using the High Precision Vaporizer 
and Autosampler.  
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Picarro isotopic water analyzers are not calibrated for water vapor 
concentration. If high accuracy water vapor concentration is 
desired, calibrate your system with a dew point generator that can 
introduce vapor streams of known concentration.  

13.4 Performing Calibration Measurements 

Since the Picarro analyzer is extremely linear, it is only necessary to use 
three calibration standards to calibrate each isotopic species (two points 
define the calibration line and a third intermediate point is used for 
verification). The exact value of each calibration standard is not of 
particular importance, as long as they span a representative range of 
values over which the analyzer will typically be operated. Although it is not 
necessary to use more than three standards, additional standards can be 
used to further constrain the linear calibration coefficients. 

Each calibration standard should be introduced into the analyzer for an 
interval long enough for the analyzer to yield a stable measurement of that 
sample. In the case of water isotopes, it is important to ensure sample-to-
sample isotopic memory is overcome prior to using injection pulses for 
calibration. For example, if there is a large difference in the isotopic 
composition of two adjacent standards, it is important to increase the 
number of injections per vial for the purpose of calibration. For example, if 
the system is calibrated directly with VSMOW and SLAP, which represent 
the largest natural variability in oxygen and hydrogen isotopes, Picarro 
recommends at least 10 injections are made per vial prior to averaging 3-5 
injections for the purpose of calibration. Such a high number of injections is 
not required for samples that are more closely spaced in isotopic 
composition. 

For routine daily calibration, secondary standards can be interspersed with 
samples during a given run. The order in which you run the standards can 
provide information about parameters, such as drift and sample-to-sample 
isotopic memory, that are helpful in assessing data quality. Picarro 
recommends the following daily calibration procedure: 

 Measure three standards that bracket the expected 
composition of samples at the beginning of the autosampler 
run.  

 Measure one of those standards again in the middle of the 
autosampler run. 
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 Measure the three same standards again at the end of the 
autosampler run. 

At the completion of the autosampler sequence, the standards can be used 
to construct a bracketed calibration. Plot the measured values of the 
standards on the x-axis, and the known values (versus VSMOW-SLAP) of 
those standards on the y-axis. A linear regression can then be used to 
correct your sample data to the VSMOW-SLAP scale. If necessary the 
standard that was run at the beginning, middle and end of the autosampler 
sequence can be used to correct drift. Finally, remember that standard 
operating procedure is to discard the first three injections for any sample 
vial and then average the remaining injections to get the value of that 
water. The total number of injections made, and the number discarded can 
be optimized based on performance requirements and the sample-to-
sample jumps in isotope space. It is possible to correct sample data to the 
VSMOW-SLAP scale by post-processing the Coordinator output data. 
Alternatively, Coordinator data can be analyzed using ChemCorrect™. 
Finally, if there is a desire to update the on-screen readings, the Picarro 
software can be updated by following the instructions given in the next 
section.  

13.5 Updating the Instrument Calibration for Accurate On-
Screen Readings 

Once you have measured your standards, you can use either of the 
methods described below to calibrate the analyzer. Method 1 requires you 
to make a graph (known standards versus measured standards) to 
calibrate the analyzer. Method 2 does not require you to make a graph; 
however, the effect of this calibration is harder to reverse than Method 1. 

Method 1: Using the CRDS Data Viewer to Update the On-
Screen Readings 

For isotope standard measurements, plot the analyzer’s reported isotope 
value on the horizontal (x) axis and the standards’ known isotopic 
composition on the vertical (y) axis. This graph will help you to determine 
the linear relationship between the known calibration values and the 
analyzer’s reported values.  

Calculate a linear best-fit equation from the data. The slope and intercept 
of the best-fit line through these points are the two values that are used to 
calibrate the analyzer. Determining the linear relationship between the 
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known values and the analyzer’s reported values enables the calculation of 
a calibration offset (slope and intercept). This adds a correction term to the 
analyzer’s factory or previous calibration. 

The analyzer’s calibration is intended to be altered infrequently. Instead of 
recalibrating frequently to increase the accuracy of the data, users often 
verify the calibration by measuring three or more water standards and 
using the same regression procedure described here to calculate an offset 
by which to correct their data offline (see previous section). In the 
calibration example data below, fitting the three standards yields the linear 
equation y = 0.9866x + 5.2658 with the slope m = 0.9866 and the intercept 
b = 5.2658. This equation would be used with x = raw data measured by 
the analyzer (labelled “CRDS Reported”) to give y = corrected data 
(labelled “Certified” value). 

 CRDS Reported Value Certified Value 

Calibration Point #1 200.1 202.7 

Calibration Point #2 600.3 597.6 

Calibration Point #3 400.0 400.0 

 

Figure 55: 
Linear 

Calibration 
Example 

 

Enter these calibration values into the software by selecting the “User 
Calibration” from the Tools menu on the CRDS Data Viewer. Enter the 
slope and intercept for each species. This is a password-protected 
function, with the default password “picarro." 
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Figure 56: 
User Cal 

Dialog 

 

After the calibration is entered, it will take effect immediately after clicking 
“OK.” 

To return to the factory calibration, simply set the slope to “1” and the 
intercept to “0” for each species. 

This calibration approach and functionality is available across all Picarro 
analyzers. In the example data given above the species measured were 
CO2, CH4 and H2O concentration. The same method applies for isotope 
data, including  δ18O,  δ17O,  δ2H.  

Method 2: Using the “Picarro Data Recalibration Tool” to 
Calibrate the Analyzer 

This tool can be used after you have performed the calibration 
measurements of standards with your Picarro analyzer. 

The Picarro Data Recalibration (“Data Recal” icon) software can be found 
in the “Picarro Utilities” folder in the desktop, and it can be used to 
recalibrate the data analyzed by Picarro analyzers.  
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Figure 57: 
Data 

Recalibration 
Tool 

 

1. Double-click the “Data Recal” icon to pull up the window to the left. 

2. Click on “Clear Entries” to reset the values in the “Picarro Data 
Recalibration” window. 

3. Enter data values into the “Certified” (expected delta values). 

4. Enter data values into the “CRDS Reported” (delta reported by 
Picarro analyzer) columns. 

5. Check the boxes in the “Used for Recal” column that you want the 
software to base the calibration on. 

6. Click the “Compute” button. The recalibrated values will appear in 
the rightmost column called “Recalibrated.” 

7. Click “Apply New Cal” if you want to apply the calibration to your 
future measurements. 

8. The default User Calibration Password is “picarro.” Click “OK” to 
continue. NOTE: This action cannot be undone from the “Picarro 
Data Recalibration Window,” but it CAN be undone in Method 1 in 
the “User Calibration” window. 
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Figure 58: 
Password 

Window 

 

9. Review the values in the window, and click “YES” to confirm, then 
OK to continue. 

Figure 59: 
Confirmation 

Windows 
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10. You now have the option to save your calibration settings. Click 
“Cancel” if you don’t want to save your new calibration setting. 

Figure 60: 
Save 

Calibration 
Dialog 

 

11. You have now calibrated your analyzer. The next time you do any 
sample measurements, the on-screen measurement readings will 
be based on the new calibration setting. 

13.6 Literature and Other Useful Resources 

There are many useful resources regarding calibrating systems for 
accurate water isotope measurements. A non-exhaustive list is below:  

 International Atomic Energy Agency (1993) “Reference and 
intercomparison materials for stable isotopes of light element”, 
IAEA Technical Document 825.  

 Schoenemann, S.W., Schauer, A.J., and Steig, E.J. (2013) 
“Measurement of SLAP2 and GISP  δ17O and proposed 
VSMOW-SLAP normalization for  δ17O and 17O-excess”, Rapid 
Communications in Mass Spectrometry, doi: 10.1002/rcm.6486 

 Van Geldern, R. and Barth, J.A.C. (2012) “Optimization of 
instrument setup and post-run corrections for oxygen and 
hydrogen stable isotopes measurements of water by isotope 
ratio infrared spectroscopy (IRIS)”, Limnology and 
Oceanography: Methods, doi: 10.4319/lom.2012.10.1024 

 Wassenaar, L.I., Coplen, T.B., and Aggarwall, P.K. (2014) 
“Approaches for Achieving Long-Term Accuracy and Precision 
of  δ18O and  δ2H for Waters Analyzed using Laser Absorption 
Spectrometers”, Environmental Science and Technology, doi: 
10.1021/es403354n 
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14. BEST PRACTICES AND OPERATIONAL 
TIPS 

14.1 Pulse Customization 

Pulse Analysis  

There is a delay of a few seconds at both the beginning of the pulse and 
the end of a pulse where the pulse analysis ignores incoming data. 
Therefore, only the most stable center portion of the pulse is included in 
the pulse analysis. Although the default settings should be adequate for 
most uses, one can adjust the delays by editing the appropriate 
Coordinator .ini script. Please be sure to keep a copy of the original file in 
case of any mistake. The example below is for the High Precision Mode 
Coordinator on a L2130-i with a Picarro Autosampler. 

 Edit the validTimeAfterTrigger or validTimeBeforeEnd fields in the 
following file: 

C:\Picarro\G2000\AppConfig\Config\Coordinator\CoordinatorLIMS_G2000_
A0325.ini 

The default settings are: validTimeAfterTrigger = 100, 
validTimeBeforeEnd = 15 

 One can similarly adjust the level that triggers a pulse analysis event by 
changing the 6500 value in the upslope or downslope trigger in the following 
file: 

C:\Picarro\G2000\AppConfig\Config\Coordinator\ 
CoordinatorLIMS_G2000_A0325.ini  

The default settings are: thres1Pair = [6500, 30000] and 
thres2Pair = [5500, 30000] #this is the downslope trigger 

14.2 Adjusting Injection Volume 

For best results, liquid sample injections should be provided to the 
instrument at a concentration of 20,000 ± 1,000 ppmv (parts per million 
by volume). Each liquid injection will be labelled as “good” in the 
coordinator if this concentration is between 17,000 - 23,000 ppmv. If the 
concentration is significantly above or below this range (i.e., < 16,500 
ppmv or > 25,000 ppmv) or if the dry background is > 500ppmv, the pulse 
will not be analyzed and the data will not appear in the coordinator.  
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To achieve the appropriate injection concentration:  

1. Dry nitrogen or zero air (< 50ppmv water concentration) should be 
supplied to the instrument at 2.5 ± 0.2psi (17.2 ± 1.4kPa), with a 
flow of approximately 200 sccm (Standard Cubic Centimeters per 
Minute). If Drierite (or similar) is used for the dry air (rather than a 
nitrogen or zero air tank) supply, a measured background level of ~ 
100-200ppmv will produce satisfactory data. Remember to select 
the Measurement Mode appropriate to your background gas matrix 
(see section Switching Between Measurement Modes.)  

2. Sample injection volume (controlled by Autosampler) should be set 
at ~ 2μL.  

If the resulting concentration peak after the 2nd or 3rd liquid injection 
is substantially different from 20,000 ppmv:  

1. The injection volume may need to be scaled appropriately: for 
example, if the resulting concentration peak of an initial ‘test’ 
injection is 16,000 ppmv, then the injection volume needs to be 
adjusted by the factor 20,000/16,000 = 1.25. To accomplish this, 
multiply the current injection volume in the Autosampler method by 
1.25.  

2. The injection quality may need improvement. Bad Injections can 
cause incorrect injection concentrations. Bad injections can be from 
a clogged needle, damaged vaporizer septum, or incorrect dry gas 
pressure/flow restriction. For rapid optimization of injection volume 
use the high throughput coordinator. 

 

Five failed injections will lead to a Time Out: Every time there is a 
liquid injection into a vaporizer by the Autosampler, a pulse of 
water vapor should enter the cavity and be analyzed. If something 
goes wrong (e.g., syringe breaks), and the pulse analysis fails, the 
software will try injecting five times in a row. After 5 failed injection 
pulses, the coordinator will time out. You will need to restart the 
coordinator to continue the experiment. This is a built-in safety 
mechanism that helps prevent un-intended sample contamination 
following multiple pierces of the vial septum. 
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14.3 Syringe Lifetime 

A common failure in liquid water analysis is syringe breakage. These 
consumable parts, although replaceable, can be expensive. We 
recommend the following best practices for enhancing syringe lifetime.  

Summary: 

 Recommended syringe size: 10 µL  

 Manually clean syringe between each autosampler run:  

 With deionized water 

 Make sure plunger moves smoothly in the barrel 

 Use a lubricant, like N-Methyl-2-pyrrolidone (NMP), if necessary 

 Use the Autosampler Training program (rather than the 
Autosampler Controller program) to change the syringe  

 Check syringe injection and fill speed, and the injection depth  

Details 

Picarro analyzers ship with 10 µL syringes from SGE Analytical Science 
(10 µL syringe part # 002982, 10R-C/T-5/0.47C). The thicker plunger on 
these syringes makes them more robust than 5 µL syringes. They also 
tend to last longer, even without the use of lubricant. 

Even though the precision of the injection volume with a 10 µL syringe is 
slightly worse than from a 5 µL syringe, the improved concentration 
dependence of our most recent isotopic water analyzers (in particular the 
L2130-i and the L2140-i) means there is no degradation in the precision of 
isotopic measurements. 

Syringe Injection, Fill Speed And Injection Depth: 

If syringes frequently break after 20 or 30 injections, double check the 
Autosampler training. Here are some parameters to check: 

 The syringe fill and inject speed. On the Picarro Autosampler, 
we recommend 0.5 µL/sec.  

 The depth to which the needle penetrates into each vial when 
drawing up a new sample. If this “sample depth” is too deep, 
the syringe’s needle can hit the bottom of the vial, eventually 
causing breakage of the needle.  
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Syringe lubricant:  

Although recommended prior to 2012, Picarro no longer uses a syringe 
lubricant, such as NMP (N-Methyl-2-Pyrrolidinone), to lubricate a syringe 
during a run. Dependent on your sample type, manually cleaning a syringe 
with NMP between runs can still be desirable.  

To clean the syringe between runs: 

1. When using the Picarro Autosampler (part number A0325), close 
the Autosampler Control at the end of the run.  

2. Open the Autosampler Training tool by double-clicking the icon on 
the desktop. Select configuration from the menu on the left, and 
then click on the text “Syringe Volume.”  

3. Select syringe size in the pop-up window. This is useful when 
exchanging the syringe or changing from a 5 to 10 µL syringe.  

4. Click on “Syringe Exchange.” The Autosampler will now move to the 
pre-programmed syringe exchange position.  

5. Remove the syringe and manually rinse the syringe using NMP until 
the plunger moves easily in the barrel. Spin the plunger while rinsing 
it with NMP, so that all sides of the plunger move smoothly through 
the barrel. Be careful not to pull out the plunger aggressively and 
then force it back into the syringe. This can cause the plunger to 
crumple.  

6. Once the syringe is moving freely, rinse it manually 3 or 4 times 
using deionized water.  

7. Re-insert the same syringe back into the Autosampler, click “Next” 
on the screen, and manually depress the metal block holding the 
plunger, as per instructions on the screen. This is important as it 
sets the dead volume of the syringe. 

8. Close the Autosampler Training tool using the Exit button. Then 
re-open the Autosampler Controller to create the next run's 
sequence. This manual cleaning takes less than 5 minutes, and it is 
a worthwhile addition to standard protocols performed between 
runs. 

 

Picarro does not recommend using NMP with the Micro 
Combustion Module (MCM). The MCM acts to destroy interfering 
organics, such as ethanol and methanol, using an oxidative 
catalytic technology. If a small amount of NMP enters the vaporizer, 
it may volatilize and be oxidized in the MCM. This will introduce 
exogenous water vapor, and potentially skew the isotopic signature 
data. 
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Samples with Precipitates 

The High Precision Vaporizer can operate with liquid waters containing as 
much as approximately 200 g/kg total dissolved solids (TDS). In principle, 
water samples can be analyzed without filtration, especially if the 
precipitate has settled and the syringe is collecting water from near the top 
of the vial. However, running samples with high TDS will decrease syringe 
life, require more vaporizer maintenance, and possibly decrease the 
lifetime of the vaporizer valves (which must be replaced in the factory).  

Therefore, samples should be filtered or centrifuged when possible. The 
"purer" the liquid being injected into the vaporizer, the longer the syringe, 
septa, and vaporizer can go without replacement or maintenance.  

Dissolving the precipitate by lowering the pH of the fluid is not 
recommended for these reasons: (i) the sample will likely fractionate, and 
(ii) introducing acid to the vaporizer, stainless steel tubing, and potentially 
the cavity, may result in corrosion that requires repair. 

14.4 Analyzing Samples with High Total Dissolved Solids 

Picarro’s High Precision Vaporizer can be used to measure saline 
samples. However, these samples present two unique challenges to 
instrument performance and lifetime: 

1. Salty samples generate residue in the syringe, which decreases 
syringe lifetime. See the Syringe Lifetime section in this manual for 
more information on increasing syringe lifetime when running salty 
samples. 

2. Upon vaporization, dissolved solids create a residue in the 
vaporizer, which can increase the memory effect and influence data 
quality. 

Memory refers to the effect of the previous sample on the current 
measurement due to carryover of trace amounts of the previous sample. 
Water is especially subject to this effect because it adheres to surfaces 
even at temperatures well above the boiling point. It is a common problem 
encountered by all methods of isotopic analysis. 

In Picarro analyzers, the memory is a function of the entire assembly 
(vaporizer, connection to the analyzer, and the analyzer itself). It is 
commonly accounted for by performing multiple injections of the same 
sample. 
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The simplest way to correct for memory is to ignore the first 2 or 3 
injections of a sample and only use the later injections. For waters with 
closely clustered isotopic values, this usually means running 6 injections 
per sample and ignoring the results of the first two injections. In more 
extreme cases, running 8 injections and ignoring the first 3 or 4 will yield 
better results.  

The effect of memory is stable over time. This means that the same 
percentage of the previous sample is carried over to the new sample each 
time.  

However, memory should be characterized every one to two months, 
particularly if samples with high levels of insoluble material or high 
dissolved solids are frequently analyzed. These materials build up in the 
vaporizer and can increase the retention of old sample.  

This effect can be quantified using the following procedure: 

1. Inject a sample of water at least 20 times (40-50 times is 
preferable).  

2. Switch to a new sample with significantly different (> 100‰ for  δ2H) 
isotopic value and inject the new sample the same number of times 
as the previous sample.  

3. Switch back to the original sample and again measure that multiple 
times.  

4. Calculate the ‘true’ value of each sample by averaging the last 5 to 
10 injections of that sample.  

5. Then subtract an individual injection from the ‘true’ value of the 
previous sample and divide this by the difference in isotope space 
between the ‘true’ value of the current sample and the previous 
sample. This will yield a memory coefficient (in percent) for each 
injection, x, where, for example 99% means that 99% of the true 
isotope difference between two samples of water has been attained 
after x injections. The first injection of sample will be in the range of 
94% to 97%. By the 4th injection, it will be approximately 98% for  
δ2H and 99% for  δ18O. Typically, the memory effect is larger for  
δ2H than for  δ18O. 

If you are running salty samples and you see a decrease in the memory 
coefficient, Picarro recommends cleaning the vaporizer. The vaporizer 
might need cleaning approximately every 200 mg of salt injected, and the 
cleaning will take about 12 hours of downtime. Contact Picarro to receive 
instructions on cleaning the vaporizer, or to the order the Vaporizer 
Cleaning Kit (part number C0211).  
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Although vaporizer cleaning will improve the performance of your 
High Precision Vaporizer, salt build up can decrease the lifetime 
vaporizer valves and eventually lead to valve failure. This is 
particularly true if salts get into the valves themselves, preventing 
good seals at the valves. Vaporizer valves can only be replaced in 
the Picarro factory. 

14.5 Sample and Standard Handling 

Sample Storage 

Whenever possible samples should be stored in sealed vial in a refrigerator 
or freezer. If samples are frozen prior to analysis it is essential to have 
sufficient headspace in the vial to prevent breakage during phase change, 
and to ensure the entire sample is returned to liquid form prior to isotope 
analysis. Parafilming the cap of the storage container is also 
recommended. If samples are stored in 2 mL autosampler containers, the 
cap with septa should be replaced once pierced.  

Two types of autosampler vial are recommended for use with your Picarro 
Autosampler: 

 2 mL glass vial with cap and septa (Picarro part number C0322, 
or as part of a consumables kit, C0328 or C0329) 

 If samples or standards are limited, it is also possible to use 2 
mL vials with 250 µL inserts. These vials act to limit headspace 
for small samples. Picarro recommends the use of fixed inserts 
to avoid water vapor passing between the insert and the wall of 
the larger 2 mL vial. For example, Agilent LS Screw Vial 
(Agilent part number 5188-6591, available from Fisher 
Scientific).  

Standard Storage 

Selecting the proper containers for long term storage is critical to avoid any 
change of isotope composition with time due to evaporation or exchange. 
The following is a list of storage methods for isotope standards.  

Glass ampoules: The most reliable containers are glass ampoules that 
are sealed with a gas torch, such as those provided from the International 
Atomic Energy Agency with VSMOW2 and SLAP2. After filling and sealing, 
ampoules can be sterilized by heating the ampoules to about 105°C 
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overnight. This will eliminate the possibility of the growth of algae or other 
biological activities. Leaking ampoules should be discarded.  

Stainless steel barrels: Internal laboratory standards can be stored in 
stainless steel barrels (25 to 50 liters). These barrels can be obtained from 
suppliers for the juice, wine and beer processing industries. When using 
this method, water standards should be kept under a slight overpressure of 
argon or nitrogen gas. The dispensing system ideally consists of a valve 
with a tube down to the bottom of the barrel to extract the water and a 
second valve with a manometer and tube connector to keep a headspace 
overpressure of inert gas in the barrel. Due to the overpressure in the 
barrel, water can be dispensed by opening the first valve. The laboratory 
standard has no contact with the atmosphere and therefore no risk exists 
of any evaporation during storage. 

Amber vials and glass bottles: For routine work, a 250 mL glass bottle 
can be filled from the appropriate internal laboratory standard barrel. 2 mL 
aliquots of these standards can then be moved to a standard autosampler 
vial with septa cap for routine, daily calibration. Glass bottles should be 
filled from their source on a regular basis (every few weeks), without 
discarding the remaining portion of the standards. This handling method 
minimizes isotope fractionation during evaporation and exposure to air 
while the bottle is open.  

It is recommended that once an autosampler vial is pierced by a needle, 
that the vial be discarded and not used repeatedly. For example, if a multi-
day autosampler run is set up, the first standard water should not be used 
again for the last standard water in the sequence. Exceptions can occur if 
the cap with septa is replaced between the first and last analysis. Once a 
septa is pierced the sample is susceptible to isotopic fractionation due to 
evaporation and loss of the water through the cap.  

Recommended Reading: 

Tanweer, A., Groening, M., van Duren, M., Jaklitsch, M., Poltenstein, L. 
(2009) “Technical Procedure Note No. 43 Stable Isotope Internal 
Laboratory Water Standards: Preparation, Calibration and Storage.” 
Isotope Hydrology Laboratory, International Atomic Energy Agency, 
Vienna, Austria. 
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15. SERVICE AND MAINTENANCE 

15.1 Particulate Filter for Analyzer 

The advanced, rugged design of Picarro analyzers provides stable, long-
term operation with minimal service or maintenance. With the exception of 
the particulate filter, the analyzer is not user serviceable. Should it appear 
to malfunction, please refer to the Troubleshooting chapter of this manual 
or contact Picarro.  

Particulate filters can become clogged after years of use in dirty 
environments. The symptoms of a clogged filter include the analyzer 
reporting “pressure low” or there being no flow into the instrument, causing 
unusual measurements. 

If liquid water is accidentally sucked into the inlet line, it will clog the filter 
and impede the flow (usually for a few days) until the water evaporates. If 
this occurs, it is important to NOT turn off the analyzer or replace the filter 
until the filter is dry. The reason for this is that the increased humidity due 
to liquid water in the filter can cause condensation on the optics if the 
analyzer is allowed to cool from its operating temperature. Often, after the 
filter dries, the analyzer will begin functioning normally, and a filter 
replacement is not necessary. 

There are two in-line, sub-micron particulate filters before the 
measurement cavity: 

 The first filter is user-replaceable and is found immediately 
following the inlet at the back of the analyzer. Replacement 
filters can be purchased from Picarro to be installed by the 
user. 

 The second filter, which is directly attached to the cavity, is 
NOT user-replaceable. NEVER remove this filter, as it is directly 
attached to the cavity. 

Tools Required 

 2 mm hex driver 

 9/16” open end wrench 

 5/8” open end wrench 

 11/16” open end wrench 
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Removing the Old Particulate Filter 

The following procedure is ONLY for the user-serviceable particulate 
filter (first filter). 

1. Move the analyzer to a clean work environment. Verify that the AC 
power cord is NOT attached to the instrument. Removing the cover 
while power is applied to the analyzer could result in exposure to 
Class 3B laser radiation.  

2. Using a 2 mm hex driver, remove the top lid of the analyzer by 
removing six M3 x 6 mm socket flathead screws. 

3. Loosen the two screws on the inner long side of the bigger box. 
Open the lid.  

Figure 61: 
Loosen Inner 

Cover Screws 

 

4. Using a 5/8” wrench, loosen the retaining nut on the input bulkhead 
(about 1 full turn should be enough). 

5. Slide the foam towards left side of the analyzer (from the back of the 
analyzer) to remove it. 

Figure 62: 
Foam Removal 

and Retaining 
Nut Loosening 

 

Remove two 
screws. 
Remove two 
screws. 

Remove foam 

Loosen this 
retaining nut on the 
input bulkhead. 
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6. Using the 9/16” and 11/16” wrenches, loosen the two nuts that are 
securing the filter to the analyzer. 

Figure 63: 
Loosening 
Filter Nuts 

 
 

 

7. Slide the filter slightly towards the back of the analyzer and lift it out. 

Hold the old filter 
steady with 11/16” 
wrench here. 

Loosen the first nut 
with 9/16” wrench 

Hold the old filter 
steady with 11/16” 
wrench here. 

Loosen the second 
nut with 9/16” wrench. 
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Figure 64: 
Filter Removed 

 

Installing the New Particulate Filter 

 

When re-attaching 1/4” Swagelok fittings, the nut should be hand-
tightened and then turned an additional 1/8 of a turn using a 
wrench. 

1. Remove the filter from its packaging.  

2. Using the 9/16” and 11/16” wrenches, attach it to the two nuts. The 
arrow on the filter needs to point away from the back of the 
analyzer.  

Figure 65: 
Installing New 

Filter 

 

Retaining Nut 

Nut New Filter  Nut 
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3. Reposition the filter foam cover, then using a 5/8” wrench, tighten 
the retaining nut on the bulkhead fitting. The metal edge of the filter 
cover should be under the foam. 

4. Close the inner cover and secure with the two screws. 

5. With a 2mm hex driver, reattach the analyzer’s top with six screws. 

15.2 Vaporizer Injection Port Septum 

The injector port septum should be replaced every 200-300 injections. The 
more closely grouped the needle piercings are on the septum, the earlier 
the septum will need to be replaced. If the septum is not changed, it will be 
difficult to maintain the vacuum inside the vaporizer, which will degrade the 
quality of the data. 

Tools Required 

 Tweezers 

 New Septum 

Replacing the Septum 

1. Is your autosampler running (i.e., actively injecting samples)? 

 If yes, click the Change Septum button in the Coordinator 
window. This button is used to pause the autosampler and 
the vaporizer in the middle of an analysis to physically 
change the septum on the vaporizer. 

Figure 66: 
Change 

Septum Button 

 

 If no, proceed directly to step 3. If you happen to click on 
the Change Septum button in the Coordinator window 
anyway, the software will wait indefinitely. To resolve this: 

 Start a job on the autosampler, or 

 Manually end the Coordinator window 



 
 

 

142 P/N 40035 Rev. F L21x0-i Inst/Op Manual 

2. Wait for the Change Septum button to change to Septum Changed 
(see below). This will happen when the current injection analysis is 
complete. 

Figure 67: 
Septum 
Change 

Sequence 

   

3. Remove the protective metal cover around the injection port (ensure 
that the insulation foam stays attached to the cover). 

Figure 68: 
Septum 

Removal 

 

4. Unscrew the cap of the port. 

 
CAUTION 

BURN HAZARD: The bottom of the cap is very hot. 

5. The old septum will usually stick to the port, but if it is in the cap, use 
tweezers to remove the old septum. 

6. Insert a new septum into the cap and screw the cap back onto the 
port by hand until it comes to a hard stop. This should be finger-
tightened only. 

 
CAUTION 

EQUIPMENT DAMAGE: Do not over-tighten or use a wrench, as the 
injector port will be damaged. 

7. Replace the metal cover around the injection port. 

Unscrew with 
wrench. 

Remove by hand. 
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8. If you had not used the Change Septum Button in the Coordinator 
window to change the septum, you are finished. Otherwise, click the 
Septum Changed button. The analyzer will restart the vaporizer 
purge cycle and then wait for the next sample injection. 

15.3 Cleaning 

Clean the outside of the analyzer and peripherals with a clean dry cloth. 
Only certified service technicians should access or clean the inside of the 
analyzer. 
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16. TROUBLESHOOTING 

16.1 Analyzer Troubleshooting 

The following section lists problems that may be encountered during 
installation and operation of the analyzer. The corresponding step-by-step 
procedures provide resolution in most cases. If, after attempting these 
procedures, the problem remains unresolved, please contact Picarro 
Technical Support. More troubleshooting information is available on the 
Community section of our website. Choose from the following symptoms: 

Power LED on Analyzer Does Not Illuminate 

Context: Turning on the analyzer by momentarily depressing its front panel 
power switch should apply power. The green power LED is illuminated 
when it detects the correct power levels. 

 Check that the AC power cord is attached and plugged into a 
working outlet. 

 Check that the rear on-off switch near the AC power cord is in 
the on position. 

 Press and hold the front panel power switch for at least 5 
seconds as the analyzer may take several seconds to respond. 

User Interface Program Does Not Start 

Context: The computer is typically configured to automatically start the 
instrument and its associated user interface program after booting up. If it 
does not start automatically, the program may be launched by double-
clicking the “Start Instrument” icon on the desktop. Communication 
problems with the analyzer may occur if the analyzer fails to initialize 
correctly on power up. 

 Shut down the computer using the following procedure only: 

1. Click on the computer’s “Start” menu in the lower left hand corner. 

 

Do not simply restart Windows by selecting “Restart” in the drop-
down box on Step 3, since this does not cycle the power to the 
analyzer. 

 

2. Select the red “Shut Down” button. 
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3. Select “Shut down” in the drop-down box. 

4. Wait for the computer and analyzer to turn off completely and the 
shutdown to complete normally. 

5. After a few seconds, restart the computer by momentarily 
depressing the front panel power button. 

Sample pressure cannot be controlled to the appropriate 
value for concentration measurements 

Context: Under normal operation, the cavity pressure is automatically 
locked to the correct value by means of electronically controlled inlet and 
outlet valves. The message “Pressure Locked” on the front panel display 
and the user interface indicates that the cavity pressure is at the 
appropriate value. Should either of the messages “Pressure high” or 
“Pressure low” be displayed, the cavity pressure is out of its correct 
operating range.  

 The “Pressure low” message indicates that there is insufficient 
gas available at the inlet of the analyzer. Check the inlet 
plumbing to the analyzer and ensure that the pressure at the 
inlet is within the specifications. 

 The “Pressure high” message indicates that gas cannot be 
removed from the analyzer at a sufficient rate. Check the 
vacuum line between the analyzer and the power vacuum unit 
for leaks. Failure of the vacuum pump, injecting dilution gas at 
excessive pressure, or excessive pressure at the inlet can also 
cause this problem. 

User interface Program “Freezes” And Does Not Update 
Graphs as Data Are Collected 

Context: The computer may become unresponsive, causing the programs 
that control the analyzer to stop functioning. The computer and analyzer 
should be shut down and restarted. 

If the computer responds to the mouse, a normal Windows shutdown may 
be carried out: 

1. Click on the computer’s “Start” menu in the lower left hand corner. 

2. Select the red “Shut Down” button. 

3. Select “Shut down” in the drop-down box. 

4. Wait for the computer and analyzer to turn off completely and the 
shutdown to complete normally. 
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5. After a few seconds, restart the computer by momentarily 
depressing the power button. 

If the computer does not respond to the mouse: 

6. Hold down the power switch on the front panel for a few seconds 
until the computer and the instrument power off. 

7. After another few seconds, restart the analyzer by momentarily 
depressing the power button. 

16.2 ChemCorrect Troubleshooting 

This section lists solutions to a common problem that may be encountered 
while using the ChemCorrect software.  

ChemCorrect Processing Software Hung Up (froze).  

Recommendation: Check that you ran a coordinator compatible with 
ChemCorrect. Coordinators for the 17O-excess mode are not compatible 
with ChemCorrect. Coordinator output csv files should contain columns 
with baseline_shift for L2130-i and L2140-i. 

If the above checked out, the other usual cause is syntax error and/or 
missing/empty row(s) in the coordinator output file. The three files listed 
below are user-editable: 

Instruction Set: C:\Picarro\ChemCorrectExe\chemcorrect_inst xx.csv  

Standard Library: C:\Picarro\ChemCorrectExe\standards file.csv  

Coordinator Output csv file or source file: HBDSxx _CC_IsoWater_xx.csv 

The instruction set is usually not edited unless you’re an avid user. The 
standards file syntax is not too complicated to follow. The most common 
errors occur in the coordinator output file. These are the items to check: 

The number of injections that you set ChemCorrect Analysis to ignore has 
to be less than the total injections/sample. 

There can’t be any empty row or blank value (as a result of broken/bent 
needle, or sample ran out of liquid). This is not an issue if you have 
ChemCorrect version 1.2.0 or later. 

“Line” column has to be sequential and start at 1  

 “Time Code” column has to be chronological. 

Port number should correspond with the correct sample number. 
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If you have to edit this source file, use Excel (an exception to all previous 
warnings to use Notepad++ because it's a lot easier – but be careful). 
When done editing, close the file, when asked "Do you want to save 
changes...?", click "yes", when asked to keep the format, click "yes”. 

Sometimes above syntax errors will crash ChemCorrect and you won't be 
able to run the software, instead an error message pops up with a path to 
the error log file. If this happens, please report this bug to help us improve 
our software. The temporary work around is to delete this file 
"chemcorrect.clt" in the ChemCorrectExe root directory. 
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17. TRANSPORTATION and STORAGE 
If the instrument will be transported or stored, the following procedure can be used 
to prepare the instrument and repack it into the original carton. All original packing 
materials the analyzer was shipped with should have been retained. 

1. Ensure clean dry gas is still attached to the instrument prior to 
shutting down. This prevents condensation inside the system during 
storage or shipment. 

2. Click the “Shutdown” button on the GUI (see Shut Down section of 
this manual for details). 

3. Disconnect all tubing and electrical connections from the analyzer. 

4. To prevent contamination and possible damage to the connector 
threads, place caps on all gas connections. 

5. Place the analyzer in a plastic bag with a packet of desiccant. Seal 
the bags with tape. 

6. Pack the analyzer in the original shipping container ensuring that all 
of the foam pieces are in place to protect the analyzer during 
shipping. 

 
CAUTION 

Equipment Damage: When shipping or relocating the analyzer, it is 
important to protect it from mechanical shocks. Failure to do so 
can compromise its performance. When shipping the analyzer, use 
its original packaging only. 
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18. LIMITED WARRANTY 
Picarro, Inc. warrants its Products to be free from defects in material and 
workmanship and to perform in the manner and under the conditions specified in 
the Product specifications for twelve (12) months from shipment. 

This warranty is the only warranty made by Picarro with respect to its Products and 
no person is authorized to bind Picarro for any obligations or liabilities beyond this 
warranty in connection with its Products. This warranty is made to the original 
Purchaser only, is non-transferable and may only be modified or amended by a 
written instrument signed by a duly authorized officer of Picarro. Sub-systems 
manufactured by other firms, but integrated into Picarro Products, are covered by 
the original manufacturer’s warranty and Picarro makes no warranty, express or 
implied, regarding such sub-systems. Products or parts thereof which are replaced 
or repaired under this warranty are warranted only for the remaining, un-expired 
portion of the original warranty period applicable to the specific Product replaced or 
repaired. 

 

DISCLAIMER 

THE FOREGOING WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER 
WARRANTIES WHETHER WRITTEN, ORAL OR IMPLIED, AND SHALL BE THE 
PURCHASER’S SOLE REMEDY AND PICARRO’S SOLE LIABILITY IN CONTRACT OR 
OTHERWISE FOR THE PRODUCT. PICARRO EXPRESSLY DISCLAIMS ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

The Purchaser’s exclusive remedy with respect to any defective Product shall be to 
have Picarro repair or replace such defective Product or credit the Purchaser’s 
account, whichever Picarro may elect in its sole discretion. If it is found that any 
Product has been returned which is not defective, the Purchaser will be notified 
and such Product returned at the Purchaser’s expense. In addition, a charge for 
testing and examination may, at Picarro’s sole discretion, be made on any Product 
so returned. 

These remedies are available only if: i) Picarro is notified in writing by the 
Purchaser promptly upon discovery of a Product defect, and in any event within the 
warranty period; ii) Picarro’s examination of such Product discloses to Picarro’s 
satisfaction that such defects actually exist and the Product has not been repaired, 
worked on, altered by persons not authorized by Picarro, subject to misuse, 
negligence or accident, or connected, installed, used or adjusted otherwise than in 
accordance with the instructions furnished by Picarro. 

The following warranty conditions shall apply to all Picarro, Inc. products unless 
amended by a written instrument signed by a duly authorized officer of Picarro: 
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ADJUSTMENT – No electrical, mechanical or optical adjustments to the product(s) 
are permitted. 

PARTS AND LABOR - New or factory-built replacements for defective parts will be 
supplied for twelve (12) months from date of shipment of the product. Replacement 
parts are warranted for the remaining portion of the original warranty period. There 
will be no charge for repair of products under warranty where the repair work is 
done by Picarro, Inc.  

NOT COVERED BY THE WARRANTY – Damage to any optical surface from 
improper handling or cleaning procedures. This applies specifically to those items 
subjected to excess laser radiation, contaminated environments, extreme 
temperature or abrasive cleaning. Damage due to ESD, abuse, misuse, improper 
installation or application, alteration, accident, negligence in use, improper storage, 
transportation or handling. No warranty shall apply where the original equipment 
identifications have been removed, defaced, altered or where there is any 
evidence of alterations, adjustments, removal of protective outer enclosure, any 
attempt to repair the product by unauthorized personnel or with parts other than 
those provided by Picarro, Inc.  

DAMAGE IN SHIPMENT - Your analyzer should be inspected and tested as soon 
as it is received. The product is packaged for safe delivery. If the product is 
damaged in any way, you should immediately file a claim with the carrier or, if 
insured separately, with the insurance company. Picarro, Inc. will not be 
responsible for damage sustained in shipment. All Picarro products are F.O.B. 
origin, shipped from the Picarro factory or Picarro distributor. The price of all 
Products, unless otherwise specifically stated, is Ex- Works, Sunnyvale, CA as 
defined by Incoterms, 2001. The cost of normal packaging for shipment is included 
in the invoiced price. Where Buyer specifies special packaging, a charge will be 
made to cover any extra expense. 

CLAIMS ASSISTANCE - Call Picarro, Inc. Customer Service or your local 
distributor for assistance. Give our representative the full details of the problem. 
Helpful information or shipping instructions will be provided. If requested, estimates 
of the charges for non-warranty or other service work will be supplied before work 
begins. 

RETURN PROCEDURE - Customers must obtain a Return Merchandise 
Authorization Number from Picarro, Inc. prior to returning units. Products being 
returned for repair must be shipped in their original shipping cartons to avoid 
damage. 
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REMOTE DATA ACCESS 

A.1 Picarro Serial Communication 

The analyzer supports an RS-232 physical command interface, which can 
be used to control the instrument and to retrieve concentration data. Not all 
features of the instrument are available on the serial interface. For details 
on how to use the serial command interface, please see the Programming 
Guide (included in pdf format on the installation CD). This command set 
may also be used across a TCP/IP interface through an Ethernet 
connection. Please contact Picarro for further details. 

A.2 Remote Data Access 

Using the RemoteAccess.ini file, the analyzer can be configured to 
automatically: 

 Send data from the instrument to a list of e-mail accounts. 

 Measure the offset of the host computer system clock from a set of 
Internet time servers and (optionally) to resynchronize the clock 
based on this information. 

The Internet connection need not be permanent and may be a dial-up 
connection accessible via a user-supplied USB modem. The task of 
sending data and/or synchronizing the clock on the analyzer is performed 
using the C:\Picarro\G2000\HostExe\RemoteAccess.exe program. This 
program can be set up to run periodically using the Windows task 
scheduler at a user-configurable frequency. If a dial-up connection to the 
Internet is employed, it is used only on demand to minimize the connection 
time. 

Each time that the RemoteAccess.exe program runs, it appends 
information to a log file, which keeps a record of the results of the time 
synchronization and of the files sent by e-mail. The RemoteAccess.exe 
program is configurable by means of an initialization file, which includes 
information such as the login credentials for the dial-up connection, the e-
mail account and the list of time servers. 

The initialization file is: 

C:\Picarro\G2000\AppConfig\Config\UtilitiesRemoteAccess\RemoteAccess
.ini 



 
 

 

152 P/N 40035 Rev. F L21x0-i Inst/Op Manual 

and it should be placed in the same directory as the executable 
RemoteAccess.exe. The file has one required section named LOGGING 
and three optional sections named NTP, DIALUP, and EMAIL. The logging 
section has a single key Logfile whose value is the path to the log file. 
Once this log file exceeds 64K bytes in length, it is backed up, appending a 
numeric extension to the file name, and a new file is opened. A total of ten 
backup log files are kept. 

NTP 

The NTP section controls querying the Internet time servers using the 
SNTP protocol (RFC4330) and the resetting of the clock on the host 
computer. If the section is not present, time synchronization is not carried 
out. The keys Server1, Server2, etc., are used to specify the URLs of the 
time servers. If the UpdateClock key is set to “true,” the offset is applied to 
the host clock. Otherwise, the offset is recorded, but the host clock is not 
changed. 

Email 

The EMAIL section controls the sending of the data files as e-mail 
attachments. If the section is not present, e-mail messages are not sent. 
The key Directory specifies the directory that contains the data files. When 
the program is run, files in this directory are sent to the specified recipients 
and the files are deleted. To avoid problems with incomplete files, 
programs that place files into this directory should do so using an atomic 
operation, such as a rename. The Server key is set to the name of an 
RFC2821- compliant SMTP server that sends the e-mail messages. 

The FROM key is the e-mail address from which the messages are sent. 
Note that some SMTP servers check that the source is permitted to send 
email while others allow any name in this field. The collection of e-mail 
addresses to which copies of the e-mail is sent is specified by the keys 
To1, To2, etc. The Subject key is used to fill the subject field in the email 
header and may be set to any string. Depending on the SMTP server, it 
may be necessary to use authentication before e-mails can be sent, as 
described in RFC2554. If such authentication is not needed, the key 
UseAuthentication is set to false. If this key is set to true, two additional 
keys Username and Password must also be specified for the e-mail 
account. 
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Dial-up 

The DIALUP section is used if a dial-up connection to the Internet needs to 
be established when the program runs. If the section does not exist, a 
permanent connection is assumed to be available for carrying out the other 
tasks specified in the initialization file. The connection name key specifies 
the name of the dial-up connection to use, as listed under Network 
Connections in the Control Panel. The values of the keys Username, 
Password and Number are used to make the connection. 

Examples of “RemoteAccess.ini” File 

[LOGGING] Logfile=c:/temp/RemoteAccessLog 

[NTP] 

Server1=time-a.nist.gov  

Server2=time-b.nist.gov  

Server3=time-a.timefreq.bldrdoc.gov  

Server4=time-b.timefreq.bldrdoc.gov  

Server5=time-c.timefreq.bldrdoc.gov  

Server6=time.nist.gov 

Server7=time-nw.nist.gov  

UpdateClock=1 

[DIALUP] 

ConnectionName=Picarro Dialup  

Access Username=user 

Password=password  

Number=14085551212 

[EMAIL] 

Server=smtp.servername.org  

Directory=c:/picarro/mailbox  

From=instrument@picarro.com  

To1=recipient1@site1.com  

To2=recipient2@site2.com 

Subject=CRDS data from Silverstone instrument  

UseAuthentication=0 
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THE DATA FILE VIEWER 

B.1 Introduction 

The Picarro Data File Viewer software is located in the Picarro Utilities 
folder on the desktop. The software allows the user to graph and to 
conduct statistical analysis of the raw data. Additional functions include 
Allan Variance plot and quadratic or polynomial fittings.  

The Picarro Data File Viewer includes two main menus: File and New. 

 

Figure 69: 
File Menu 

 

 

Figure 70: 
New Menu  

 

B.2 The File Menu 

This section describes the functions available from the Data File Viewer File 
menu. 

Open H5 

File > Open H5 opens a Picarro data file (HDF5 format) for data analysis and 
visualization. After opening the data file, you can create a new time series 
plot. Refer to New Time Series Plot for more information. 
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Load Config 

File > Load Config loads a configuration file (ini format) to restore 
parameters of a workplace. Refer to Save Configuration for more information. 

Unpack Zip File 

Use File > Unpack Zip File to concatenate all H5 files inside the zip file into 
a single H5 file. Refer to Concatenate H5 Files for details. 

Concatenate H5 Files 

Use File > Concatenate H5 files to concatenate multiple files and zip 
archives of H5 files into a single H5 file. Navigate to the desired folder or use 
the Define date range button to specify a date range of files to concatenate. 
(See next section.) 

After selecting the path of the data files, Data File Viewer will automatically 
search an H5 file in the specified zip/folder and look for all available 
variables in the H5 file. The variables are then listed in the left panel, and 
users can use “>>” button to move variables to the right panel for 
concatenation. 

Figure 71: 
Select Variables 

Form  
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Define Date Range 

Data File Viewer can search data files within the desired date range and 
then concatenate such files into an H5 file. 

By default, TimeZone is set to your local time zone. However, if data were 
taken elsewhere, select the time zone where data were taken. 

Select File > Concatenate H5 files, then click Define date range to specify 
the desired date range. 

Figure 72: 
Defining Date 

Range  

 

Data files are saved in directory trees named by date and time option.  

Picarro software saves data in a directory tree that is named by the 
creation year, month, and day. (See example directory tree in the following 
image.) Select this option if the target folder has this file structure. This 
way, Data File Viewer will only search folders within the desired date 
range, which can substantially reduce processing time. 

Figure 73: 
File Structure of 

Data File 
Viewer  
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NOTE 

To save processing time, Data File Viewer does not open data files, 
but only determines data acquisition time based on the file name. 

 

 
CAUTION 

Do not define a time range for data files whose names have been 
changed. 

 

 
NOTE 

Data File Viewer does not concatenate data files exactly within the 
defined time range. This is because the time extracted from file 
name is different from the data acquisition time. To not miss data 
points, Data File Viewer expands the specified time range, so the 
resulting dataset normally has a wider time range than the user 
specification. 

Convert DAT to H5 

Select File > Convert DAT to H5 to convert a file in DAT format to HDF5 
format. These formats are described below: 

 DAT format: DAT files accepted by DatViewer store tabular data 
(numbers and text) in plain text. 

 Each line of the file is a data record. Each record consists of one or 
more fields separated by whitespaces. 

 The first line of data file indicates column names. 

 There must be a field “EPOCH_TIME” to store the acquisition epoch 
time (expressed as seconds since Jan 1, 1970) of the data. 
Otherwise, the first and second fields must be “DATE” and “TIME”. 
The “DATE” field must have the format “mm/dd/yyyy” or “yyyy-mm-
dd”, and the “TIME” field must have the format “HH:MM: SS(.sss)” 
where (.sss) is an optional fraction of seconds. 

 HDF5 format: HDF5 is a data model, library, and file format for 
storing and managing data. (See the HDF5 Home Page on the HDF 
Group Web site for more information.) When converting DAT to 
HDF5 format, Data File Viewer creates a table named “results” to 
the contained data. 
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Convert H5 to DAT 

Select File > Convert H5 to DAT to convert a file in a HDF5 format to 
DAT. These formats are described in Convert DAT to H5. 

 
NOTE 

Data File Viewer does not concatenate data files exactly within the 
defined time range. This is because the time extracted from file 
name is different from the data acquisition time. To not miss data 
points, Data File Viewer expands the specified time, column name 
“fineLaser-Current_1_controlOn” will be replaced with 
“fineLaserCurr_1_ctrlOn”. 

Interpolation 

Interpolation describes the method for constructing data points with a 
range of a discrete set of known data points. Select File > Interpolation to 
perform interpolation on a time grid with a constant interval. 

Block Average 

Select File > Block Average to divide a dataset into small blocks based on 
a user-defined block size. The average is calculated for data in each block, 
and the results are saved in a new H5 file. 

 

 
NOTE 

The specified block size must be greater than the average data 
interval. 

Because the data interval is normally not a constant (unless interpolation is 
performed), fluctuations in the data interval will affect block averaging if the 
block size is comparable to the average data interval. 
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B.3 New – Time Series Plot 

You can specify to include create time-series plots with one, two, or three 
frames. New plots display in the Time Series Viewer. 

Figure 74: 
Time Series 

Viewer  

 

The next section describes the options available on the Time Series Viewer 
menu bar. Refer to Time Series Viewer Canvas on page 163 for 
information the Time Series Viewer UI features and options. 

B.4 Time Series Viewer Menus 

The Time Series Viewer form includes the following menus: 

Figure 75: 
Time Series 

Viewer Menus  
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Time Series Viewer File Menu 

Use the File menu to save a configuration or take a screenshot. 

Figure 76: 
Time Series 

Viewer – File 
Menu  

 

Save Configuration 

Click File > Save Configuration to open the Feature Capture form. With 
this form, you can save figure properties, expressions, filters, and other 
settings to a configuration file so that it can be easily loaded in the future. 

Figure 77: 
Time Series 

Viewer – 
Feature Capture  

 

 

 
CAUTION 

If a feature is not captured, it will be omitted when the configuration 
file is loaded. 

Depending on the features captured, loading a configuration file can have 
different effects. For example: 

 If all features are captured, a saved workplace is reproduced. 

 If Data file is not captured, saved parameters will be applied to the 
data file in memory. 

 If Expression is not captured, plots will not be transformed. 

 If X (Y) range is not captured, figures will be auto-scaled on the x (y) 
axis. 
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Take Screenshot 

Use File > Take ScreenShot to take a screenshot of the Time Series 
Viewer and save it as a .png to a specified file. 

Time Series Viewer Analysis Menu 

Use the Analysis menu to calculate statistics, generate a histogram, and to 
plot correlations and Allan Standard deviations. 

Figure 78: 
Time Series 

Viewer – 
Analysis Menu  

 

Statistics 

Use Analysis > Statistics to calculate mean, standard deviation and peak 
to peak for all plots in the current window. 

Histogram 

Use Analysis > Histogram to generate a histogram of data as shown 
below. 
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Figure 79: 
Histogram 

Window  

 

 Red Line: A Gaussian function fitted to the histogram. Fitting results 
of μ and σ are shown in the top-left corner of the plot. 

 Bin: Specifies the number of intervals that the range of values is 
divided into. 

 Normalized: When selected, the sum of the histograms is 
normalized to 1. 

 Save data: Saves histogram data to a CSV file. 

 Save image: Saves the histogram image as a JPEG/PNG/PDF file. 

Correlation Plot 

Use Analysis > Correlation Plot to plot Y-axis data in one frame versus 
that in the other. This can be used when two or more frames exist in the 
current Time Series Plot window. See Correlation/XY Plot on Page 166 for 
details. 
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Allan Standard Deviation Plot 

Use Analysis > Allan Standard Deviation Plot to create an Allan 
Standard Deviation plot (versus a standard deviation plot) for data in the 
current window. See Allan Variance for more information. 

Time Series Viewer View Menu 

Use the View menu to view X-axis information in date-time, minute, or hour 
format. 

Figure 80: 
Time Series 

Viewer –  
View Menu  

 

 

 
NOTE 

When switching from DateTime to Minute or Hour, the X-axis data 
is subtracted from the earliest point shown in the panel and then 
converted to the desired unit.  

The Time Series Viewer Canvas 

The Time Series Viewer canvas is comprised of interactive graphs and a 
variety of configuration options. 

Figure 81: 
Time Series 

Viewer Canvas  
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Mouse Options and Graph Transform 

The following mouse actions can be used in the canvas graphs: 

 Left click and drag: Zooms into the selected area of the plot. 

 Left click and drag with the SHIFT key down: Pans the plot. 

 Left click and drag with CTRL key down: Zooms out from the plot. 

 Left click and drag with ALT key down: Stretches the plot. 

 Right-click: Opens an additional menu. Refer to the next section. 

Right-click Menu 

Right-clicking on the canvas provides opens a pop-up menu. 

Figure 82: 
Canvas Right-

click Menu  

 

Export Image: Exports the current plot as a jpeg, png, or pdf file. 

Export Data in Current View: Exports only date/time and the selected 
variable in the current view to an HDF5 or CSV file. 

Export All Data in Current Time Range: Exports all variable columns of 
the selected dataset in the current time range to an HDF5 file. Refer to 
Concatenate H5 Files on page 155 for more information. 

Edit Plot properties: Opens the Image Editor form, where the following 
options can be specified: 

 Title: Edits the title of the plot. 

 Line: Specifies the line pattern of the plot. If None is selected, the 
data points will be plotted without connecting lines. 

 Marker: Specifies the marker type to indicate data points. If None is 
selected, data points will not be shown. 

 Min and Max: Specifies the minimum and maximum of data range 
for the X-axis and the Y-axis. 

 x[0]: Sets the earliest time of the dataset as the minimum of the X-
axis. 
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 Time zone: Sets the time zone for date/time variables. This defaults 
to the local time zone. 

 Label: Specify a label for the X-axis and the Y-axis. 
 

Figure 83: 
Image Editor 

Form  

 

 

 Statistics: Calculates the mean, standard deviation, and peak to 
peak for data in the current view. 

Dataset Name and Var Name 

An HDF5 file can store one or more tables. Each of these tables is called a 
Dataset. A table can contain one or more columns. Each column is called a 
variable (Var). 

Use the Dataset name drop down to select the dataset that will be used for 
this time series graph. Use the Var name drop down to select the column 
in the dataset to use in the graph. 

Autoscale Y 

When the Autoscale Y option is selected, the Time Series Viewer will 
autoscale on the Y-axis to make sure that all data within the range of the X-
axis is displayed. 
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Average 

If Block is selected, a block average is calculated when you click the Do 
average button is clicked. Otherwise, a moving average is calculated. 

For a block average, Size specifies block size in unit of a minute. For a 
moving average, Size specifies subset size in unit of data points. 

 

 
REMINDER 

Averaging is performed after the Filter and Expression are 
performed. 

Mean, Std Dev, and Peak to Peak 

The Mean, Std dev (Standard deviation) and Peak to peak fields provide 
all the statistical information of data in the current view. 

Correlation/XY Plot 

The Correlation/XY Plot window includes two menu items: File and 
Analysis. For details about the File menu, see Save Configuration on  
page 160. 

 
REMINDER 

The canvas in this plot is interactive. For details about the plot 
canvas, see The Time Series Viewer Canvas on Page 163. 
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Figure 84: 
Correlation/XY 

Plot 

 

Analysis Menu 

The Analysis Menu includes three options: Fitting, Integration, and 
Statistics. 

Figure 85: 
Analysis  

Menu 

 

 Fitting allows you to specify one of four fitting methods to include in 
the Correlation/XY plot: 

 Linear fit: Specifies to fit to linear function y = c1x + c0 

 Quadratic fit: Specifies to fit to quadratic function y = c2x2 + c1x 
+ c0 
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 Polynomial fit: Specifies to fit polynomial function of degree n: 
y = Σcnxn 

 Curve fit: Specifies to use non-linear least squares to fit an 
arbitrary function to data.  

 Integration calculates area under the curve using the composite 
trapezoidal rule. 

 Statistics calculates mean, standard deviation, and peak to peak 
for data in the current view.  

After applying any of the above Analysis options, the results, statistics, or 
fitting function with coefficients are displayed in the lower portion of the 
Correlation Plot window.  

Figure 86: 
Results of 
Quadratic 

Fitting 
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EXTERNAL VALVE 
SEQUENCER 

C.1 Introduction 

The Picarro analyzer can control two types of valves: 

 Solenoid valve(s): DC voltage powered valve with normally open 
(NO) and normally closed (NC) positions. These can be either 2-
way or 3-way valves. 

 Rotary Selector valve: digitally controlled valve used to send 
selected flow from one of many inputs (up to 32) into the analyzer 

Both types of valves can be simultaneously controlled through a common 
software interface called the ‘External Valve Sequencer,’ which is available 
from the Tools menu in the GUI. 

C.2 Default Configuration 

For all models of Picarro analyzers, the rotary valve control is disabled in 
the factory default setting. The solenoid valve control, however, is ready to 
use by default for all solenoid valve connectors. 

C.3 Setting Up Solenoid Valves 

The Valve Sequencer software can control up to six solenoid valves. Each 
valve should operate using 12 VDC with a current requirement of <1.5 
Ampere maximum. This analyzer comes with a cable that can be 
connected to the solenoid valves. 

The valve connector cable should be connected to the 15-pin connector at 
the lower left corner of the analyzer. There are six pairs of wires with 
connectors labeled V1, V2, … V6 with 2-pin female Molex connectors 
(Molex#43020-0200) for connection to the solenoid valves. For valves 
wired with matching Molex connectors, connect V1 to the solenoid valve 1, 
V2 to solenoid valve 2, etc. Do not connect the solenoid valve to the 
analyzer ground -- use only the provided electrical connectors. 
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C.4 Setting Up Rotary Selector Valve 

A multi-position rotary selector valve can be controlled by the Valve 
Sequencer software. It is controlled by standard serial commands in the 
Valco (VICI) protocol. Valco rotary valve models SD, SC, SF, ST, and STF 
are all supported. However, not all configurations will be appropriate, due 
to tube diameter, pressure or materials of construction. This setup will also 
require a Valco micro electric high torque actuator. A single combination 
package such as EMT2ST16MWE includes a 16 position, low- pressure 
ST valve in stainless steel, 1/8” tubing, 2” standoff, and micro electric high 
torque actuator. Please refer to http://www.vici.com/vval/st_8-1.php#16pos 
for further options and consult with Valco directly for more details. 

The Valco controller should be installed per manufacturer’s instructions. 
The 9-pin female, connector cable (female) should mate with its 
corresponding, male port of the analyzer and labeled “MPV.” Please note 
the 9-pin connector cable is not supplied with the instrument. 

 

Figure 87: 
8-port Valve 

Setup  
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C.5 Valve Sequencer Software 

The Valve Sequencer software allows the user to set steps in which 
solenoid valves are turned on/off and the rotary selector valve is set to a 
single position. The Picarro valve sequencer window appears below: 

Figure 88: 
Valve 

Sequencer GUI  

 

The current step, elapsed duration, and valve states are shown in the 
topmost row of the valve sequencer command window. The duration of 
each step is set in minutes; for example, 1 minute and 30 seconds 
correspond to 1.5 minutes. 

Please note the number of steps correlates with the total steps in the 
sequence, and the count of the steps starts at “0.” The first step in the 
sequence is designated Current Step “0,” and the second step in the 
sequence is designated Current Step “1.” The “Go to First Step” menu item 
under “Action” restarts the sequence from step 1. 

Different sequences can be created and saved in the software. Use the 
“Sequence File #” field to select which file the sequence will be saved to (0 
to 10 are the available choices). Click the up/down arrows to select the 
desired number. 
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C.6 Configuring a Valve Sequence 

Each “step” sets the rotary valve to a single position and activates the 
indicated solenoid valve(s) for a set period. Multiple steps can be carried 
out in sequential order to switch between different gas sources, flush out a 
manifold, or other gas handling operation. Create the number of desired 
steps in the sequence by clicking the up/down arrow for “steps.” 

For each step, select the box for each solenoid valve to be opened. The 
checkmark in the “current valve state” window indicates a solenoid valve is 
open. Note: In this example, we assume normally closed (NC) valves are 
used. A check indicates current is flowing to the valve thus powering it 
open. The positions from left to right correspond to solenoid valves 
V1…V6. 

The rotary selector valve position can be set in the column labeled “Rot. 
Valve Code.” Enter the number that corresponds to the desired valve 
position. A value of 1 in this field corresponds to position 2 on the Valco 
valve. Only one rotary position can be selected per step. 

Step duration is determined by the value entered in the “duration (min)” 
field, where the duration of the step is in minutes. If duration values are set 
to <0.1 minutes, they may not be carried out correctly. 

The “valve code” field is a configuration- dependent, read-only display field 
that shows the total state of that particular step in a numerical code. Should 
the most upper right gray box display a value of 512,256 or be grayed-out, 
either no rotary selector valve is connected to the instrument, or the valve 
is not functioning. For each individual measurement, the analyzer makes, 
the valve codes and rotary valve positions corresponding to the valve 
state(s) at that point in time are saved alongside the concentration data. 

Once the valve sequence has been programmed, it can be saved using the 
button “Save Valve Sequence File.” The sequence will be saved under the 
sequence file number selected. 
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C.7 Loading and Running a Saved Sequence 

To load a valve sequence file, select the desired “sequence file number” 
and press “Load Valve Sequence File.” If the user has been running a 
different sequence from the one that was loaded, the user needs to press 
“Next Step” to initialize the newly selected sequence. 

To run a sequence file, press “Enable Sequencer.” This button will turn to 
“Disable Sequencer” once the sequence starts. (The sequencer should be 
activated if it was disabled, but not necessarily to change from one 
sequence to another.) The sequence will repeat itself indefinitely until 
disabled or the software is exited. If enabled, the sequence will continue to 
run after the “close sequencer window” button is pressed. 

If desired, the valve sequence can be forwarded to the next step of the 
sequence by pressing the “run next step” button. To stop the sequencer 
file, use the “Start/Stop Sequencer” menu item under the “Action” menu. 
This will leave all valves in their current state. In some situations, it is 
convenient to program the last step in the sequence to be a safe or default 
valve state. The sequencer can be advanced to the last step should the 
user need to put the solenoid or rotary valves into a safe/default state. The 
“Reset All Valves” de-activates all valves. Using the “Hide Sequencer 
Interface” closes the window, but if the sequencer is enabled, it will 
continue to run in the background. To jump to a particular step, increment 
the “run step 3” and click “Apply.” 

Both solenoid and rotary valve codes are recorded in columns in the output 
data files indicating the active valve configuration respective to when data 
is taken. These codes can be used as event timing flags. For example, if 
no solenoid valves are present, the codes will be recorded regardless of 
whether a valve is connected or not 




